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1. Introduction 

The iPECS UCS (Unified Communications Solution) Client is a PC based application, which operates 

in conjunction with the iPECS UCS Server, expanding and enhancing the communication services of 

iPECS to dramatically improve business productivity and customer responsiveness.  In addition to the 

rich voice services available with the iPECS system, users of iPECS UCS Client have access to a wide 

range of video, text and graphic collaborative and messaging services.  Services available include 

Presence, Video Conferencing, Instant Messaging, Sharing (Application, Desktop and Whiteboard), 

Individual Call Routing (ICR) and more.  Employing a simple intuitive graphical user interface, the 

UCS Client has access to both private and shared scheduling and directory database applications, which 

are fully integrated with the various services available.  Further, the UCS Client database applications 

can interoperate and synchronize with major personal information management applications and 

databases such as Outlook, ACT!, Goldmine, Excel and LDAP.  The UCS Client user interface is 

highly flexible and can be customized to address the needs of the individual user.  As an Internet 

Protocol (IP) solution, the UCS Client overcomes geographical limitations allowing access to services 

and databases while in the office or on the road. 
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2. Install and Setup 

Installation and set-up of the iPECS UCS Client is a simple three-step process: 

1. Install the iPECS UCS Client application on the user’s PC. 

2. Adjust UCS Client login settings. 

3. Login to complete registration of the iPECS UCS Client application to the iPECS system and 

UCS Server. 

Completing the login and registration process may require assistance from the iPECS Administrator to 

adjust settings of the iPECS system and the UCS Server; both will require the Client User ID and 

Password.  Also, iPECS UCS Client will require entry of the host iPECS system and UCS Server IP 

address. 

Prior to installation, the PC and operating system should be verified for compatibility with the iPECS 

UCS Client application.  Assure that the PC and Operating System (OS) comply with the minimum 

requirements of Section 2.1. 

 

2.1 PC Hardware and OS Requirement 

The UCS Client application software requires a PC with the minimum configuration defined below. 

Hardware: 

 Pentium IV (Core2 Duo 3 or higher, required for 4CIF video usage) 

 1 GB Bytes of DRAM (2GB required for 4CIF usage) 

 200 M Bytes of HDD storage 

 Monitor, 17” recommended, with a resolution of 1024 x 768 

 100/1000 Base T NIC (Network Interface Card) 

 CD ROM drive 

 Standard Keyboard 

 Standard Mouse 

 Web Cam, optional for Video Conference 

 Sound card and Microphone installed 

 USB headset (recommended) 

 

Note: Voice quality is highly dependent on the quality of the headset and type. 

 

Operating System: 

 Windows XP 

 Windows Vista 

 Windows 7 
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2.2 License and Lock Key 

Prior to registration of iPECS UCS Clients with the host iPECS system and UCS Server, the host 

iPECS system will require installation of a UCS Client software license.  iPECS UCS employs a 

concurrent-user (floating) license scheme.  In this scheme, the maximum number of active (logged in) 

UCS Clients is set by the number of clients allowed by the installed lock-key.  The lock-key 

installation is permitted only by an authorized agent of LG-Ericsson.  For information on Lock-keys, 

contact the local Ericsson-LG distributor. 

 

2.3 iPECS UCS Client Installation 

This section explains how to install the iPECS UCS Client.  The software can be obtained by 

download from the iPECS UCS Web Admin Download Client Program window or from the iPECS 

UCS Client CD-ROM.  Download from the iPECS UCS Web Admin may require assistance of the 

UCS Administrator.  To obtain the software by download: 

1. Open a browser on the PC. 

2. Point the browser to http://ip address of UCS Web Admin/UCS, the UCS Administrator should 

have the IP address. 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Click the ‘Click to download UCS Client Program’ link at the lower-left of the screen. 
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4. Select the Windows (PC) Download button.  

The Windows File Download Security screen 

displays. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. Select Save to save the UCS Client application 

in the designated directory 

OR 

6. Select Run to install UCS client directly on the 

PC. 
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To install the UCS Client application: 

1. If Run was selected in step 6 above, the UCS 

Client Install Wizard appears.  If Save was 

selected; 

2. Find and run the UCSClient.exe file received 

during download. 

3. The UCS Client Install Wizard should 

appear. 

4. In the Install Wizard screen, and click Next. 

 

 

 

5. The software License Agreement window 

appears.  Read and accept the license terms, 

and click on Next. 

 

 

 

 

 

 

6. In the Customer Information window, enter a 

User Name and Organization; select the 

radio button for all users or Only for me, and 

then click Next. 
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7. In the Destination Folder window, you may 

either accept the default destination 

(C:\Program Files\UCS Client), which is 

recommended 

OR 

Select Browse to locate a different directory 

or specify a directory.  If you specify the 

directory, do not include spaces or special 

characters. 

 

 

 

8. Click Next to install WinPcap.  WinPcap is 

a-standard tool for link-layer network access 

in the Windows environment.  The 

WinPcap Installer is imbedded in the UCS 

Client Installer, and opens automatically. 

 

 

 

 

 

 

9. The WinPcap software License Agreement 

window appears.  Read and click I Agree to 

continue the installation.  The WinPcap 

installer begins copying files onto your hard 

disk. 
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10. After successful installation of WinPcap, 

click Finish to complete WinPcap 

installation. 

 

 

 

 

 

 

 

 

11. When all files have been downloaded, the 

Installation Completed window is shown, 

click the Finish button.  To open the UCS 

Client application when Windows starts, 

click the box for “Run UCS client 

automatically when Windows starts”. 

 

 

 

 

 

2.4 Initial Set-up & Login 

To set-up the UCS Client application, perform the following steps: 

1. Following installation, click on UCS Client from 

the Programs listing in the Windows Start menu or 

click the desktop shortcut icon created during the 

software installation. 
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2. Once launched, the iPECS UCS Client Login screen will appear.  

For the initial installation, you must define the IP address and other 

basic parameters for the iPECS system, UCS Server and client in 

the General Setting window. 

3. Select Setting from the File menu, the Server Connection window 

displays, refer to Section 4.1.3.1. 

 

 

4. Under UCS Server Connection, enter the IP Address of 

the UCS Server provided by your UCS Administrator, 

or if already shown, check Use Detected Server IP.  

5. Select OK to save the new values.  

 

 

 

 

6. When finished, login by entering your User ID and 

Password.  Remember, the ID and Password are case 

sensitive.  The User ID and Password may be 2-12 

alphanumeric characters and the Password may 

include symbol characters. 

7. In a single user environment, use the Auto Login, 

Remember User ID and Password checkboxes, to 

automate login to the iPECS system and UCS Server 

every time the UCS Client application is launched. 

8. Click Login to initiate the iPECS UCS Server and 

system login; the UCS Client Console should display. 

 

Note: 

 If no audio device is defined in the PC, a warning dialog is 

displayed and the UCS Client will not open.  With 

Windows 7 and Windows Vista, the warning message is 

also displayed if the audio device is not connected.  

Clicking ‘Yes’ in the Warning Dialog box will open UCS 

Client without audio capabilities. 

 If the number of Login attempts reaches the threshold assigned by the UCS administrator, the User 

account is locked.  To unlock the account, either the administrator must unlock the account or the 

assigned lockout duration timer must expire. 
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3. General Description 

The UCS Client Console consists of the Main application menu (File, View, Tools and Help), Message 

and Status bar, My Detail information, main window for Presence, Phone, Logs and Call View, and 

Quick Call Control bar. 

 

 

The Main application menu is discussed in Section 4. 

The Message and Status bar is discussed in Section 5. 

The My Detail Information is discussed in Section 6. 

The main Window for Presence, Phone, Logs and active Call views is discussed in Section 7. 

The Quick Call Control bar is discussed in Section 8. 

 

 



ECS       UCS Client Installation & User Guide 

 

 10 iss.3.1 

4. Main Application Menu 

The Main Application menu at the top of the console includes menu selections for File, View, Tools and 

Help. 

 

 

4.1 File Menu Selection 

Click on File to show the following selections: 

 Login/Logout – initiates the login or logout process with the 

iPECS UCS Server and system, see section 2.4. 

 Open Received Files – opens the folder where files received from 

other UCS Client users are stored. 

 Set My Presence – defines your IM presence state. 

 Set My Phone Status – sets the phone status. 

 My Information - displays your detailed information. 

 Setting – displays the Setting window, where you set up and 

customize the iPECS UCS Client. 

 Close – minimizes the iPECS UCS Client application to the 

Windows notification tray. 

 

4.1.1 Set My Presence 

Presence establishes your availability to be part of an Instant Messaging session.  iPECS UCS Server 

monitors and automatically updates your Presence as Online, Offline, Busy or In a Meeting.  The 

presence of other users is also provided in the Presence window (refer to 

Section 7.1).  Your status is displayed by the IM Status icon, which is located 

on the left above your picture.  You may change the status with the Set My 

Presence selection in the File menu, or by clicking the IM Status icon. 

 

To change the UCS Client IM status: 

1. Select Set My Presence from the File menu. 

2. Select the IM status (presence) desired from the status window 
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4.1.2 Set My Phone Status 

Using Set My Phone Status, the UCS Client can be placed in a Do-

Not-Disturb state or calls to the UCS Client may be re-routed 

(forward) to another destination.  When in DND, internal callers 

receive a fast-busy tone and outside callers re-route based on 

iPECS system admin settings.  Simple Call Forward is activated 

from the phone allowing the user to define the type of Call Forward 

(all calls, busy, and no-answer) and destination for the calls.  Remote Call Forward or Follow-me 

forward is activated from a different phone allowing the user to define the type of calls to forward and 

the destination for the calls.  For Follow-me forward, the user must also enter the station number and 

the password (Authentication code) to activate Remote Call Forward.  Call Forward ICR accesses the 

Individual Call Routing feature where the user can define various Call routing scenarios as discussed 

in Section 11. 

 

Note: When DND or Call Forward is activated, a confirmation window will display at next login, 

DND or Call Forward can be deactivated in the confirmation window. 

 

4.1.2.1 Clear All 

You may deactivate Call Forward or DND with the Clear selection in Set My Phone Status sub-

menu of the File menu, or by selecting the Phone status icon. 

 

To deactivate Call Forward or DND: 

1. Select Set My Phone Status from the File menu or the 

Phone status icon. 

2. Select Clear from the status window. 
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4.1.2.2 Set Do Not Disturb (DND) 

You may activate DND with the Set My Phone Status selection in 

the File menu, or by selecting the Phone Status icon. 

 

To activate DND: 

1. Select Set My Phone Status from the File menu or the Phone 

status icon. 

2. Select DND from the status window 

 

4.1.2.3 Set Simple Call Forwarding 

You may select to re-route incoming calls to other stations, station groups, the system Voice Mail, 

or over CO/IP resources.  You may forward calls based on your IM presence state and define the 

type or forwarding condition for calls. 

To activate Call Forward: 

1. Select Set My Phone Status from the File menu or the Phone 

status icon. 

2. Select Call Forward (Simple), the Simple Call Forwarding 

window displays. 

3. In this window click on and enter the Destination information 

(as needed). 

4. Select the IM status required to forward calls or select All IM 

Status to forward calls regardless of the IM Presence state.  

5. Select the Forwarding Type. 

6. Click OK to activate Call Forward. 

 

4.1.2.4 Set Remote Call Forwarding 

To activate Call Forward, Remote (Follow-me): 

1. Select Set My Phone Status from the File menu or 

select the Phone status icon. 

2. Select Call Forward (Remote)’, the Remote Call 

Forwarding window displays. 

3. Input your Remote Station number. 

4. Input your Station Authorization Code (Password) 

5. Input the Station or Station Group to receive calls. 

6. Select the desired Forwarding Type. 

7. Click OK to activate Call Forward.  
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4.1.2.5 Set ICR (Individual Call Routing) 

Setting Call Forward ICR (Individual Call Routing) is discussed in Section 11. 

 

4.1.3 Setting 

The Setting menu provides a number of pages to configure the UCS Server 

connection, UCS Client appearance, sound and other characteristics 

discussed in this section.  When Setting is selected in the File menu, the 

first Setting page, Server Connection, will display. 

 

 

 

 

The Setting window is divided into two screens, on the 

left is the Setting menu navigation pane and on the 

right is the data entry pane.  Selecting a category in 

the navigation pane displays the associated data pane.  

 

The following sections cover each data item in each 

category available from the navigation pane. 

 

 

4.1.3.1 Server Connection 

Normally, once the Server Connection items are entered during the initial installation further 

changes will not be required (refer to Section 2.4).  In cases where the PC has multiple Network 

Interface Cards (NICs) or a Virtual Private Network (VPN), the proper Network adapter must be 

identified.  The Network adapter is selected under the Advanced button of the Server Connection 

Setting window. 

 

To modify any of the Server Connection settings: 

1. Select Setting from the File menu, the Server 

Connection window displays. 

2. Change the desired item(s). 

3. Click Apply or OK to exit. 

 

In the Server Connection screen, the selections are: 

UCS Server Connection 
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 Use detected server IP – when the UCS Client application is launched, it attempts to 

locate a local UCS Server (if found and this item is checked, the UCS Client will use the 

located UCS Server for services). 

 IP Address – input box for the IP Address or domain name of the UCS Server.  

 Server Relay Mode – relay mode between the UCS Clients; Auto is recommended. 

- Auto – Session connection is determined by the UCS Client automatically. 

- Enable – Implements the server relay function so that the UCS Client can establish a 

connection to others when separated by a firewall.  In this case, the UCS Server acts 

as a relay to distribute session (IM, File Send and Sharing) packets to other users.  

This mode connects UCS Clients separated by a firewall. 

- Disable – Implements a peer-to-peer connection for the session. 

Call Server Connection 

 PBX IP Address – IP address of the iPECS host system serving the iPECS UCS Client. 

 Connection Mode – connection mode between the UCS Client and the iPECS; Auto 

Connection mode is recommended. 

- Auto – selects either Local or Remote automatically. 

- Local – connection is employed when the iPECS system and UCS Client are on the 

same LAN. 

- Remote – supports packet relay. 

 

Advanced Settings 

 Connect with Selected Adapter – enables selection 

of a specific network adapter. 

 Your Current IP – displays current IP Address. 

 Network Adapter Selection – displays network 

adapter list; select the desired network adapter 

 

Network Diagnostics 

 Test Start – start network diagnostics 

 Cancel – cancel network diagnostics 

 Ping Test – ping test option between a UCS Client and a 

server. 

 UDP Message Test – application message test option 

between a UCS Client and a server. 

 Send To Email – sends the test results as an e-mail 

attachment. 

 Save – saves the test result to a file. 

 Close – exit network diagnostics. 
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Defined Profiles can be selected from the drop-down list 

or added/edited/deleted with the Profile Name Tool 

buttons: 

1. Select Profile Name. 

2. Click on the Add or Edit button in the Server 

Connection screen. 

3. Click to select/deselect the Use Detected Server IP 

option. 

4. Enter the IP address, Login Timeout. 

5. Select the Server Relay Mode and Connection 

Mode. 

6. Click on OK. 

 

4.1.3.2 General 

The General category consists of several sub-categories for the Basic Action, Display and Sound 

pages.  Items on each page are discussed below.  Note that the Theme and Presence color can be 

changed only if the client is not logged-in 

 

To modify any of the General category settings: 

1. Select Setting from the File menu, the Server 

Connection window displays. 

2. Select the desired sub-category under the 

General heading. 

3. Change the desired item(s). 

4. Click on the Apply or OK to exit settings. 

 

1) Basic Action page 

The Basic Action page includes the following items: 

 Set the action for double-clicking – when double clicking on a user record in the Presence 

window, UCS Client will take the action selected from the drop-down list (Call, IM, 

Detail Information and No Action). 

 Auto-Start on Startup Window – when enabled, UCS Client opens following Windows 

opening. 

 Login Notification – if enabled, at login the login notification message is displayed. 

 Show DND or Call forward Confirm window on login – if enabled, the DND or Call Forward 

confirm window is displayed at login. 

 Enable Auto away – if enabled, when there is no activity on your computer for the Auto 

away time (minutes) you set, the IM status is set to Away. 

 Do not display expired appointments in Today’s Schedule Viewer – if enabled, once an 
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appointment expires, the appointment is removed from the My Detailed Information 

window. 

 Show confirm window when no speaker or microphone – if enabled a warning message is 

shown when attempting to open UCS Client on a PC without a speaker or microphone.  

If disabled, UCS Client will open even if no audio devices are connected to the PC.  

However, calls cannot be placed from the UCS Client since no audio devices are 

available. 

 My presence for an Appointment –the presence status changes to the entered status 

automatically at the start of a UCS schedule. 

 My presence After Expired – the presence status changes to the entered status 

automatically at the completion of a UCS schedule. 

 Busy Status Appointment – the presence of the UCS Client changes to the entered status at 

the start of an imported Outlook schedule where the presence has been set to “Busy”. 

 Out of Office Status Appointment –the presence of the UCS Client changes to the entered 

status at the start an imported Outlook schedule where the presence has been set to “Out of 

Office”. 

 

2) Display 

 Language – selects the display language 

(English or Local). 

 Themes Color – selects a theme color 

for UCS client windows.  Ten colors 

are available. 

 Presence Color – selects a color for the 

Presence screen.  Ten colors are 

available. 

 

 

3) Sound 

 Program Start Notification – when 

enabled, play the Program Start alert. 

 Program End Notification – when 

enabled, play the Program End alert. 

 New IM Notification – when a new IM 

message is received and notification is 

enabled, the new IM message warning 

tone is received.  Note the warning tone 

is not received while the IM window is 

active. 

 Administrative message Notification – 

when enabled and a message is received from UCS administrator, play the notify message 

Sound. 

 Logon Notification – when enabled and the user logs in, play the logon notification sound. 
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 Mute All Sounds – click to deactivate all sounds. 

 

4) Outlook Integration 

 Disable Outlook Security Warning – 

when enabled if the UCS Client 

accesses Outlook information such as 

the address book, mail or appointments, 

the Outlook security window is 

bypassed and the information is 

displayed. 

 Enable Outlook Schedule (Auto 

Synchronization from Outlook to UCS) – 

enables synchronization between iPECS 

UCS user’s Private schedules and 

Outlook.  At login, the UCS Client may present a confirmation window so that you may 

confirm synchronization with the Outlook schedules.  If confirmed, UCS Client will 

download the schedules from Outlook.  After login, if schedules are changed in UCS, the 

Outlook schedules are also modified. 

Note that only schedules for the current and next month are synchronized.  Schedules 

from the previous months or beyond the next month are not synchronized. 

 Set Default Folder – when checked, the UCS Client calendar is synchronized to the default 

Outlook calendar folder. 

 Show Outlook Synchronization Confirm window – when Outlook calendar synchronization 

is enabled, a confirmation window can be presented allowing you to allow or disallow 

synchronization. 

 Open Synchronized Appointments to All Shared users - when Outlook appointments are 

synchronized, the appointments are shared based on this selection.  You may select ‘Do 

Not Open to All Shared users’, Open to All Shared Users or ‘Follow the Property of 

Outlook’.  Selecting ‘Follow the Property of Outlook’ option, shares appointments based 

on sharing options in the Outlook appointment. 

 Enable Outlook Contacts (Auto Synchronization from Outlook to UCS) – when enabled, the 

UCS Client Private directory and Outlook contacts synchronize during login.  At login, 

the UCS Client may present a confirmation window so that you may confirm 

synchronization with the Outlook contacts.  If confirmed, UCS Client will download the 

contacts from Outlook.  After login, if the contacts in UCS are modified, the Outlook 

contacts are also modified.  

 Set Default Folder – when checked, the UCS Client Private directory is synchronized to 

the default Outlook Contacts folder. 

 Show Outlook Synchronization Confirm window – when Outlook contact synchronization 

is enabled, a confirmation window can be presented allowing you to confirm 

synchronization. 

 Delete All Imported Private Users Before Synchronization – If enabled, at login all 

previously imported contacts will be deleted before synchronization. 

 Show Synchronization Result - when enabled, you will be presented a window displaying 
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the results from the synchronization. 

 

4.1.3.3 Call 

The Call category includes settings for Dialing rules, call pop-up boxes and several audio settings 

as discussed below. 

 

To modify any of the Call category settings: 

1. Select Setting from the File menu, the Server 

Connection window displays. 

2. Select the desired sub-category under the 

Call heading. 

3. Change the desired item(s). 

4. Click Apply or OK to exit settings. 

 

 

 

1) Dialing Rules 

When placing an outside call from any of the UCS Client windows (e.g. Presence, Logs, etc.), 

certain digits may need to be included or removed to assure proper dialing through the iPECS 

System.  When a number is selected from a window, the UCS Client will compare the number to 

the dialing rules.  The dialing rules country and area codes are compared to the number, and if 

matched, are deleted from the number.  If not matched, the appropriate Area (LD) or 

International codes will be inserted, preceded by the PBX, CO or IP line access codes. 

 Access Codes – entered in the Dialing Rules window, along with local codes for 

comparison. 

 Add a zero before the area code when dialing within the country – if enabled, includes the 

area code with the leading zero when dialing within the country. 

 Enblock Dialing – when enabled, digits dialed for a call are sent at one time rather than 

sending each digit as dialed.  When IP Bridge mode is enabled, it is recommended that 

Enblock Dialing be enabled.  Note that for proper operation, Phonebook entries should 

follow normal conventions (ex., +country code (area code) number [ex., +41 (041) 

4904636]) 
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Advanced Dialing Rules 

 Filtering Code – code is used for special cases 

to search contact directories.  To add this 

code, please ask your system administrator. 

 Insert Numbers if ‘=’ is found – replace ‘=’ 

with assigned number.  This is useful to dial 

a long number. 

 Pause Time (ms) if ‘P’ or’,’ is found – if a 

number includes the pause code, ‘P’ or ‘,’, 

dialing will pause for the timer value in milli-

seconds set here. 

 If the area code is required for local dialing, 

the Dial Area Access Code In Same Area 

option must be checked. 

 

Special Dialing Rules 

Normally, dialed numbers that do not have an area or 

country code defined in the dialing rules are routed as 

an internal call.  Using the Special Dialing Rules, 

dialed numbers matching the defined rules are routed as 

external CO calls. 

 Prefix Digits – If the first digits in a dialed 

number match the assigned ‘Prefix Digit(s), 

the call is routed as an external CO call and 

the CO access code is added automatically. 

 Length – If the length of the dialed number is 

longer then the defined length, the call is 

routed as an external CO call and the CO 

access code is added automatically. 

 

2) Call Popup 

 Call Pop-up – check to enable the UCS version Call Popup. 
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 Outlook Pop-up – when Call pop-ups are 

enabled, the client will display either the UCS 

popup shown above or the Outlook popup, to 

the right.  Check to enable the Outlook 

Popup in place of the UCS popup.  If you 

check Internal Call, the Outlook popup will 

also display for internal calls.  The default 

folder for the Outlook contacts must be 

defined. 

 Call Popup Trigger – defines the event that 

will cause display of the selected popup, both incoming calls and outgoing calls may 

trigger the call popup. 

 Call Window Option – the Call tab in the main window can be displayed when a call is 

connected or when a call is answered or dropped with Enter key in the popup window.  

When you set ‘Display Registered Call Memo on Call Pop-up’, incoming and outgoing 

calls are displayed in the Call Memo window.  Also, if you want to activate the Call 

Memo window automatically when a call is received, select the ‘Show Call Memo Window 

Automatically’ option.  For more information about the Call Memo window, refer to 

Section 9.10.  Select the ‘Show Flex Button Window when Phone Tab is open’ to see the 

Flex Button window automatically when the Phone tab is selected. 

 

Note: For proper operation with ‘Answer/Drop a Call with Enter Key in Call Pop-up Window 

enabled, the UCS call popup must be the active window.  If the Outlook call popup is selected or 

you select a different window while the UCS call popup is displayed the call cannot be answered 

or dropped with the Enter key. 

 

3) Ring Sound 

iPECS UCS Client can provide one of four (4) 

ring signals with separate assignments for internal 

and external calls.  Each of the four (4) ring 

signals is contained in a *.wav file.  You may 

select one of the four *.wav files (ring1.wav, 

ring2.wav, ring3.wav and ring4.wav) or replace 

any of these files with a desired *.wav (PCM) or 

*.mp3 file.  

 

 Station Ring – selects the ring signal for 

internal calls.  You can check the ring signal in advance. 

 CO Ring – selects the ring signal for external calls.  You can check the ring signal in 

advance. 

 Ring Style – one of three ring volume treatments can be selected, minimum, gradually 
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increase, or at the specified volume. 

 

4) Audio 

The UCS Client will deliver tone signals (ring) as 

well as voice signals to the defined device.  Select 

a Speaker to receive Ring/DTMF and select a 

Speaker and a Microphone for voice 

communication.  The Speaker can be defined 

separately for voice and ring signals.  

 

 

 

Audio Wizard 

 Device for Ring/Tone – defines the devices for ring and 

tones.  PC Speaker Beep tone will sound for incoming 

calls if this option is enabled. 

 Device for Voice – defines the devices, speaker and 

microphone, for voice communication. 

 Audio Tuning Wizard – assists is adjusting the volumes 

for the Speaker/Microphone, see Section 4.1.3.3. 

 

 

 

There are three ring styles for an incoming call ring signal, 

minimum, gradually increase, or at the specified volume.  From 

the wizard, the style selected is played allowing you to determine 

if it is acceptable.  If you check Enable PC Speaker Beep, the 

beep is played. 
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On the Communication Test page of the wizard, you can check 

the volume level of the speaker and microphone.  Any sound 

picked up by the microphone is displayed under the microphone 

section of this page.  The volume level varies if the PC sound 

devices are properly set.  If you set Let UCS adjusts microphone 

volume, Automatic Gain Control (AGC) is used to adjust the 

microphone volume. 

 

 

 

These options can improve voice quality in noisy 

environments.  By increasing the noise suppression, noise 

patterns are removed during conversation.  For example, if 

you say ‘Ah~’, continuously, the pattern will be removed from 

the conversation. 

 

 

 

 

 Headset Integration – when headset integration is 

enabled, operation of the headset hook-switch 

function for answering or dropping a call is 

recognized when using one of several headsets.  

The supported headsets with the hook-switch 

function include: 

- Audio 910 Headset 

- CS 50/60 USB Headset, press volume up or 

down button for more than 3 seconds to dial the 

assigned numbers. 

- GN8120 Headset 

- Common Devices – Plantronics 

- Common Devices – GN Netcom (Jabra) 

 

Note: The operation of remote hook-switch varies between headset manufacturers and models.  

To use one of the listed headsets with UCS Client, refer to the manual packaged with the headset. 

 

To use the hook-switch function when a “Common Device” is selected, special Windows drivers 

are required.  These drivers are available on the UCS Server and may be downloaded using the 

link at the bottom of the Headset Integration page or from the Client download page accessed 
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from the UCS Server login page.  Also, for the Plantronics Common Devices, Microsoft .Net 

Framework 3.5 or later is required.  The UCS Client will check for this software and, if not 

installed, you will be prompted to download and install this software prior to installation of the 

drivers. 

 

5) Voice Codec 

 Select Codec – defines the preferred codec 

(System codec, G.711 or G.729). 

 

 

 

 

 

6) IP Bridge 

 Enable IP Bridge – the UCS Client can be 

linked with an iPECS desktop IP Phone so 

that a call can be placed from the client and 

the voice path established through the IP 

Phone by lifting the handset or pressing the 

Speaker button. 

 

 

 

7) Recording 

 Recording Folder – defines the folder 

where recorded call files are stored 
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8) Click to Call 

 Enable Capturing Numbers by Mouse 

Dragging - when you drag your mouse over 

a phone number in a browser window, the 

number is captured into the Quick Call 

Control Bar and the Call Assistance.  

However, capturing over several windows 

is not allowed.  For example, capturing 

will not work if you click the left mouse 

button to start in one program window and 

release mouse button in another program 

window. 

 

Note: Characters captured can be numeric digits, ‘+’ (plus sign), - (dash) and ‘,’ (comma). 

 

4.1.3.4 Functions 

Under Functions, settings are available for 

Sharing, video, IM logging and database 

characteristics as discussed in detail below. 

 

To modify any of the Function category settings: 

1. Select Setting from the File menu, the Server 

Connection window displays. 

2. Select the desired sub-category under the 

Function heading. 
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3. Change the desired item(s). 

4. Click Apply or OK to exit settings. 

 

1) File 

 File Receiving Folder – defines the folder for where files received from other UCS Clients 

are stored 

 

2) Sharing 

Application Sharing 

 Application from Share List – only shares 

files from the Shared List during a 

sharing session (refer to Section 12.3.3) 

 Any windows in the Shared Window – 

shares all windows that are moved or 

displayed in the Sharing window 

including files in the Shared List, refer 

to Section 12.3.3.  Certain types of files 

such as Internet browsers may not be 

recognized by the sharing module as 

applicable to sharing.  In this case, 

selecting Any Windows in the Shared Window allows a window to be drag to the Sharing 

window for display to participants. 

 Capture Resolution – sets the capture resolution (10, 20, 50, 80, and 100%).  Higher 

resolution improves quality but can significantly increase LAN traffic. 

 

Desktop Sharing 

 Capture Resolution – sets the capture resolution (10, 20, 50, 80, and 100%).  Higher 

resolution improves quality but can significantly increase LAN traffic. 

 

3) Video 

 Video Frame rate – sets the video frame 

rate (Slow, Normal, and Fast).  Because 

added processing time is required, faster 

frame rates may impact quality  

 Device for Video – sets the video input 

device.  If there are more than two 

devices, the user may select a device from 

the list. 

 Allow Video Request Automatically – when 

enabled, automatically answer all incoming 

video requests. 
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4) IM 

 Enable IM Log – enables the IM Log, all 

IM sessions are stored until erased, refer 

to Section 7.3. 

 Popup On New IM Message – enables 

the minimized or hidden IM window to 

popup when a new IM message is 

received. 

 IM Window Popup Position on Multi-

Monitor – sets the popup position of the 

IM window in Multi-monitor 

environments. 

- Monitor where UCS main window is shown – IM Window will be displayed at the 

monitor where the UCS Client main window is shown. 

- Primary monitor – IM window will be displayed at the primary monitor where Start 

Menu and Desktop Shortcuts are displayed by Windows. 

- Whole of Central Desktop – IM window will be displayed in the center of the screen. 

 

5) LDAP 

 Server Name – identifies the LDAP 

Server.  A LDAP server defines the 

server where UCS Server databases 

reside. 

 

 

 

 

 

 

Advanced – to view the advanced LDAP Setting window. 
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6) Video Presentation Mode 

 Master Send Frame – maximum number 

of frames that can be sent by the 

organizer. 

 Master Receive Frame – maximum 

number of frames that can be sent by the 

participants. 

Note: The organizer PC in presentation mode 

should have considerable CPU power to process 

video frames received from up to 32 users.  Using 

higher frame rates requires higher CPU power to 

process the video frames. 

 

4.2 View Menu Selection 

Selecting View shows the following selections: 

 View Selected User Detail Information – displays detail 

information window for selected user in the Presence or Log 

window. 

 Call Assistance – displays the Call Assistance window. 

 Restore Default Window – returns UCS Client main window 

to the default appearance. 

 Quick Call Control Bar – determines if the Quick Call Control Bar will be hidden or shown. 

 Phone Tab – determines if the Phone Tab will be hidden or shown. 

 Organization – determines if the Organization Tab will be hidden or shown (options set by Server 

Admin.). 

 

4.2.1 View Contact Detail 

When a contact is selected in the Presence or Log 

window, basic information about the selected contact will 

display along with an iconic view of the communication 

modes available.  Icons for available communication 

modes are highlighted while modes not available are 

shaded.  Icons and the represented communication are: 
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Start an IM session with selected user. 

Send email to selected user. 

Make a call to the desktop phone of a selected user. 

Make a call to the cell phone of a selected user. 

Make a call to the office phone of a selected user. 

Make a call to the home phone of a selected user. 

Display other menus. 

 

Initiates File Send, Sharing, Web Push or Video call with the selected user 

 

 

 

 

Note: To send files to a selected contact, drag and drop the 

appropriate file from its folder window to the Contact Detail 

window. 

 

 

4.2.2 Call Assistance 

The Call Assistance bar 

is always shown on top 

of other desktop screens 

to allow instant voice 

communications.  The bar is semi-transparent and may be dragged and dropped to an unobtrusive 

location on the desktop screen. 

 

 

Additionally, you may activate display of 

the Station LCD; right click on the Call 

Assistant and select Display LCD to view 

the Station LCD display along with the 

Call Assistant. 

 

4.3 Tools Menu Selection 

The Tools menu provides direct access to UCS Client collaboration, database and communication 
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services.  Each of the Tools menu items can be accessed from other menus and is discussed further in 

other sections of this guide as noted below. 

 Call – displays the Call menu, refer to Section 9. 

 IM – displays the IM window, refer to Section 12.1. 

 File Send – displays the File Send window, refer to Section 

12.2. 

 Sharing – contains the selections for Application Sharing, 

Desktop Sharing, Whiteboard, Web Push, and SMS; refer to 

Section 12.3. 

 Schedule – displays the Schedule window, refer to Section 

10. 

 Video – contains selections for Video (Normal Mode), and 

Video (Presentation Mode), refer to Section 12.5. 

 Chat Room – displays the Chat Room window, refer to 

Section 12.1.2. 

 IM Log – displays the IM Log window, refer to Section 7.3. 

 Import Contacts – import the contents from other contact database tools, refer to Section 

7.1.1.4. 

 Export Contacts – export the contents of the user’s contacts to other database tools, refer to 

Section 7.1.1.4. 

 Favorite Links – displays the Program & Web Link window. 

 

4.4 Help Menu Selection 

The Help menu displays this user guide in PDF format and the About screen, which contains general 

information on the UCS Client application including the version and release date.  To display the user 

guide, Adobe Acrobat Reader, which is available from the Adobe web site, is required. 
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4.5 Tray Menu 

UCS Client places a short cut button in the right notification tray.  Right clicking on the short cut 

displays one of two menus depending on the login state of the UCS Client. 

 

After Login 

 Open UCS Client – opens the UCS Client with the last 

displayed main window. 

 Tools – opens the Selected Member window to either 

‘Make a call’ or ‘IM’. 

 Presence – opens the UCS Client with presence in the 

main window. 

 Logs – opens the UCS Client with the Logs window. 

 Set My Presence – change my presence, refer to 

Section 4.1.1. 

 Set My Phone Status – change my phone status, refer to Section 4.1.2. 

 Logout – log out of the UCS Client. 

 Exit – closes and exits the UCS Client. 

 

Before Login 

 Open UCS Client – opens the UCS Client Login window. 

 Login – opens the UCS Client Login window. 

 Exit – closes and exits the UCS Client. 
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5. Message & Status Bar 

The icons for Presence, Phone and Video status are shown above the main window on the left.  These 

icons indicate the user’s current Presence, Phone and Web Cam status.  The Message icons for Voice 

Mail, SMS, Notes and Missed calls are 

shown at the right above the main 

window.  These icons indicate the 

number of unheard or unread 

messages, and give access to Voice Mail and message log windows.  

 

5.1 Message Icons 

Message icons display the number of unheard or unread messages and missed calls.  Selecting an icon 

accesses Voice Mail or the Logs window directly.  To check messages: 

1. Press the desired message icon. 

 Voice mail, refer to Section 5.1.1. 

 SMS, refer to Section 5.1.2. 

 Notes, refer to Section 5.1.3. 

 Missed Calls, refer to Section 5.1.4. 

 

5.1.1 Voice Mail 

The Voice Mail selection will access your assigned Voice mail 

server.  If you have multiple Voice mail servers and Set the VM 

as Default is checked, the VM Selection window appears and you 

may select a VM server.  If Set the VM as Default, is not 

checked, the VM Selection window is available from the Call 

menu under the Tools main menu.  The Voice mail icon is 

displayed even though no Voice mail server is assigned to your station. 

 

5.1.2 SMS 

Up to ten (10) incoming SMS messages are stored in the 

iPECS are stored.  The SMS message log is retrieved from 

iPECS by clicking the SMS icon in the UCS Client.  The 

main window then displays a log of the SMS messages. 
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5.1.3 Notes 

Notes left by other users are retrieved from the UCS 

Server by clicking on the Notes icon in the UCS Client.  

The main window displays all received Notes. 

 

 

5.1.4 Missed Calls 

Missed call information is displayed by clicking the 

Missed Calls icon.  The main window displays detailed 

logs for each missed call. 

 

 

 

5.2 Status Icons 

UCS Server monitors and displays your IM Presence, Phone and Video status icons, updating the icons 

automatically as your status changes.  In addition, the Presence and Phone icons can be used to modify 

your status as outline in Sections 4.1.1 and 4.1.2.  The Presence and Phone status can also be changed 

manually under the File selection of the Main menu.  Icons and the represented status are shown 

below. 

 IM Presence icon   Phone Status icon   Video Status icon 

  - Online     - idle     - idle 

  - busy     - busy     - busy 

  - away     - unavailable   -  - unavailable 

  - be right back   - Call Forward 

  - out of office   - DND 

  - in a meeting 
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6. My Detail Information 

Users can view and modify the information in the My Information window including today’s message, 

‘My picture’ and the day’s appointments.  In addition, the user’s detailed information and password 

can be modified using the My Information window. 

 

6.1 Setting My Picture 

The My Information window includes a user-defined picture shown to other users in the Shared 

Directory and during certain IM sessions.  The picture must be a .jpeg file, which will be resized to fit 

in the ‘My Picture’ area.  

To change the picture: 

1. Select the Picture Change button. 

2. From the Windows file directory, 

locate and select the desired file. 

3. Click Open to apply the selection as 

the My picture file. 

 

6.2 My Information and Password 

The UCS Client sends the User ID and Password to the iPECS system and UCS Server during login to 

authenticate the client.  The password can be changed from the My Information window or from the 

UCS Server Web Admin.  To change your password in the My Information window: 

1. Double click on the Picture ID to display your detailed information. 

2. Select Change Password, the Change Password 

window displays. 

3. Enter the current password. 

4. Enter and confirm the desired password in the New 

Password and Confirm Password boxes. 

5. Select OK to save the change. 

Note: The new password length must be equal to or 

greater than the minimum password length permitted 

by the UCS Administrator. 

 

To change My Information: 

1. Double click on the Picture ID to display your detailed 

information. 

2. Edit contents of any editable field.  Editable fields are set by UCS Administrator. 

3. Press OK to save the changes. 
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6.3 User Defined Message 

Users can write a message to display to other UCS 

clients. 

 

To post your message: 

1. Input the message. 

2. Press Enter button on the PC, the message is displayed in bold font. 

 

6.4 Today’s Appointments 

My Information window includes a 

display of today’s appointments.  The 

time and name of the next 

appointment is shown in the window.  

If there is more than one appointment, 

the down arrow button will display all appointments for the day.  In addition, appointments can be 

viewed, added or modified as discussed in Section 10 by clicking on the calendar to the right of the 

appointment display. 
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7. Main Window Views 

The main window has four views (Presence, Phone, Logs and Call) selectable with the tabs at the top of 

the window.  The Phone tab can be eliminated, see Section 4.1.3.2.  The Call tab only appears during 

an active call and the Call window can be assigned to automatically display when a call is placed or 

received, refer to Section 4.1.3.3. 

 

7.1 Presence Window Introduction 

The Presence window displays the status of contacts you select from one of two directories available 

with UCS.  The contacts in the Shared directory, which is managed by the UCS Administrator, are 

available to all users.  Users also have access to contacts in a second directory called the Private User 

directory.  A separate Private User directory, which is managed by the user and stored in the UCS 

Client PC, is available to each user.  The Presence window displays the status of the UCS Client, 

iPECS desktop phone, Webcam, Schedule and Remote Monitoring for listed contacts using icons.  For 

contacts not monitored by UCS, for example external Shared or Private User contacts, no status is 

available to UCS and a single icon displays their status.  The tool and status icons employed in the 

Presence window are shown below. 

 

The tool icons are: 

   Add Contact 

   Add Group 

 

The Presence icons are: 

   Offline 

   Online 

   Busy 

   Away 

   Be Right Back 

   Out of Office 

   In a Meeting 

   Blocked 

   Non-UCS Contact 

   Private Contact 

 

The iPECS Phone status icons are:  The Webcam status icons are: 

   - Idle         - Idle 

   - Busy         - Busy 
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   - Unavailable       - Unavailable, Webcam not connected at contact’s PC. 

   - DND         - Offline, contact’s PC or UCS Client offline. 

   - Call Forward 

 

The Schedule status icon ( ) displays after the contact if the Contact has established a ‘Today’s 

Schedule’. 

 

The Remote Monitoring status icon ( ) displays after the contact if the Remote Monitoring has been 

allowed by the monitored user. 

 

When a contact is selected, the contact’s information displays in the Selected Contact window just 

below the Presence window, refer to Section 7.5.  In addition, icons are available in the window for 

each available communication mode.  

 

In addition to display of status, the Presence window can be used to establish communication with the 

listed contacts.  By right clicking the mouse on a contact, one of four collaboration and management 

popup menus will display.  The popup displayed is based on status and type of the contact as below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

From these menus, you may select Make a Call to call the contact, initiate a collaborative session (IM, 

File Send, Sharing, Web Push, etc, see section 12) with the contact, block the selected user from 

receiving you presence and status information (select Block), remove the contact from your Presence 

ONLINE POP-UP NON-UCS POP-UP OFFLINE POP-UP PRIVATE USER POP-UP 
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window (Delete User) or view detail contact information (Detail Information).  In addition, for offline 

contacts, you may Leave A Note.  The following describes menu items: 

 Make a Call – places a call to the selected contact 

 Scheduled Dial – registers a Schedule Dial to the selected contact 

 Start a Video Call – Video with call (Normal/Presentation Mode) 

 IM – starts IM to the selected contact 

 File Send – starts File Send to the selected contact 

 Sharing – Initiates a sharing session with the selected contact (Application Sharing/Desktop 

Sharing/Whiteboard/Web Push) 

 Clicking popup item – starts one click sharing session with the selected contact and includes 

selected item. 

 Video – starts a Video call to the selected contact 

 SMS – sends an SMS to the selected contact 

 Email – sends an Email to the selected contact 

 Leave a Note – leaves a note to the selected offline contact 

 Block – blocks the selected user from receiving your presence 

 Detail Information – opens the selected user’s detail information box 

 Today’s Schedule Info – displays the selected user’s today’s schedule information 

 Move Selected User to – moves the selected user to another group 

 Delete User – deletes the selected user from the Presence window 

 Delete All Private Users – deletes all private users from the Presence window 

 

In addition to selecting a single contact, you can select 

multiple contacts or grouped contacts for activation of a 

function from the menu.  To select multiple contacts: 

1. Select a contact. 

2. Select additional users using the mouse and Ctrl or 

Shift key. 

3. Right-click your mouse on the contact records and 

select the appropriate function in the popup menu. 

Note: If more than five (5) online users are selected, the 

offline popup menu is displayed in place of the online menu.  

Certain functions available from the online popup are not 

available to more than six (6) users.  For example, the 

maximum number of users in a Video Conference is six, you 

and 5 other users. 
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To select contacts in a group: 

1. Select a group. 

2. Right-click on the contact records, and select a function 

from the popup menu displayed. 

 

Note: If more than five (5) online users are selected, the offline 

popup menu is displayed in place of the online menu.  Certain 

functions available from the online popup are not available to 

more than six (6) users.  For example, the maximum number of 

users in a Video Conference is six, you and 5 other users. 

 

 

 

 

 

 

The following is a brief description of menu items available. 

 Start Group Call – places a call to the selected group of contacts 

 Start Video Group Call – places a video call to the selected group contacts 

 Delete All Selected Users – deletes the selected users from the Presence window 

 Delete All Users in this group – deletes all users in the selected group from the Presence 

window. 

Group Offline Menu 

MULTI SELECT 
ONLINE POP-UP 

MULTI SELECT 
OFFLINE POP-UP 
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To Leave a Note to an offline contact: 

1. Right-click on a contact record. 

2. Select Leave a Note (only available for 

offline contacts). 

3. Enter your note in the Leave a Note window, 

maximum 100 characters. 

4. Click OK to send the Note. 

 

Users can customize the Presence window appearance with the View selection. 

 All – displays all Presence contacts 

 Share – displays only Shared contacts 

 Online – displays only online contacts 

 Blocked – displays only blocked contacts 

 Private – displays only private contacts 

 

Also, users can define the sorting order of contacts in the Presence window with the Sort selection. 

 IM – sort by IM status 

 Phone – sort by Phone status 

 Name – sort by alphabetically by Contact name 

 

7.1.1 Managing the Presence Window 

The Presence window has a number of tools to manage contacts, groups, appearance and order of 

contacts. 

 

7.1.1.1 Adding and Deleting Contacts 

Contacts in the Shared directory may be added to 

or deleted from the Presence window.  The 

Presence window also displays the Private 

directory and contacts may be added or deleted.  

The Shared contacts directory is stored in the UCS 

Server and is managed by the UCS Administrator.  

You manage the Private directory, which includes 

the following information for each contact: 

 Name and Nickname 

 Cellular Phone 

 Office Phone, Name, Department, FAX and Office Address 

 Home Telephone, Address and Email.  

Note: When adding a Private User contact, the contact name and Office Phone are required, the 



ECS       UCS Client Installation & User Guide 

 

 40 iss.3.1 

remaining fields are optional. 

 

To add a contact from the Shared directory: 

1. Select the Add Contact icon in the upper left side 

of the window. 

2. In the Select User 

Type window, select 

Add Shared User. 

3. In the Add Shared 

User window, select 

the field to search using the drop-down menu. 

4. Enter the appropriate text to search within the 

field. 

5. Click Search to display matching records. 

6. Select the user to add and click Add; the contact record is displayed in the Not Assigned Group 

in the Presence window. 

 

To add a new Private User: 

1. Select the Add Contact icon in the upper left 

side of the window. 

2. In the Select User 

Type window, 

select Add Private 

User. 

3. In the Add Private 

User window enter the contact information 

(Name and Office Phone are the required 

fields). 

4. Click OK to store and display the contact 

record.  The new contact is shown under the 

Private group and stored in the Private User directory. 

 

To delete a contact from the Presence window: 

1. Right-click on the desired record. 

2. In the popup menu, select Delete User. 

3. Click ‘Yes’ to confirm the deletion. 

Note: Deleting a Private contact from the Presence window also deletes the record from the 

Private User directory.  Deleting a Shared contact only removes the record from your Presence 

window. 
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You may also view all the information on the contact.  

To view Detailed Information: 

1. Right-click over the desired record, 

2. Select Detail Information to display the 

contact’s Detail Information screen.  The 

information for a Shared user includes the 

user’s picture and schedule for the day.  The 

information in the window is the same as the 

Add Private User window shown above. 

 

 

 

 

 

 

7.1.1.2 Organizing Contacts by Group 

For easier management, the Presence contact list 

can be divided into groups.  Groups can be added, 

deleted, renamed and contacts moved from one 

group to another.  Initially, all Shared contacts are 

placed in the Not Assigned Group and Private 

contacts are displayed in the Private group. 

 

 

To add a group: 

1. Select the Add Group icon. 

2. Type the new group name desired. 

3. Click OK to add the new group. 

 

 

To rename a group: 

1. Right-click on the desired group, the pop-up 

menu will display. 

2. Select Rename Selected Group. 

3. Enter the new group name and click OK button. 

 

To delete group: 

1. Right-click on the desired group, the popup menu will display. 
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2. Select Delete Selected Group. 

Note: All contacts must be removed from the group before it can be deleted.  Also, the 

predefined Not Assigned Group cannot be deleted. 

 

To move a user to another group: 

1. Right-click on the desired user, the pop-up menu will display. 

2. Select Move Selected user to. 

3. Select the group where the contact is to be moved, 

OR 

4. Drag and drop the user name to the desired group. 

 

7.1.1.3 Searching the Presence Window 

You may query the Presence window to locate a contact quickly.  The UCS Client will search 

the contacts listed in the window.  Text entered in 

the search box is compared to the Name, Today’s 

message and Desktop Phone 1 fields in each 

record.  If no matching records are found, you 

can extend the search to all records in the Shared 

directory or, if enabled in Section 오류! 참조 

원본을 찾을 수 없습니다., the LDAP database. 

 

To search users in the Presence window: 

1. Enter the appropriate text to search. 

 

If no matching records are found, extend the search to the 

Shared or LDAP database: 

1. Select Search Shared User or Search LDAP User. 

2. The search results window displays. 
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SHARED USER POP-UP LDAP POP-UP 

 

 

 

 

 

 

 

 

 

 

 

3. From the results window, right click to display the actions popup menu as shown below.  

 

 

 

 

 

 

 

Search Shared User 

The Search Shared User window 

shows IM status, phone status, 

Webcam status, User ID, Name, 

Desktop Phone, Cellular Phone, 

Email and schedule status and 

features of the Presence window 

are available. 

 

Note: Presence status does not 

automatically update, the display 

indicates the status when the user 

queried the database. 
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If the number of queried users exceeds 100, the first 100 results will be shown, and any other 

results will be shown on subsequent pages. 

 

 

 

 

 

 

 

 

 

 

 

 

 

7.1.1.4 Managing the Private User Directory 

The Private User directory is a list of contacts you 

can enter or import from an external Contacts 

database.  When initially entered, these contacts 

are listed in the Private group of the Presence 

window.  In addition to adding and deleting a 

Private User contact, these contacts can be edited, 

all Private User contacts can be deleted and the 

contacts imported or exported to databases 

including Outlook, Excel, Goldmine or ACT!. 

 

To edit a record: 

1. Right-click on a record; the pop-up menu 

will display. 

2. Select Edit User from the popup menu. 

3. Modify the user’s information 

4. Click OK to save. 

 

To delete all the Private User contact records: 

1. Right click on any contact or group. 

2. Select Delete All Private Users from the popup menu. 
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3. Click Yes to confirm. 

 

Importing and Exporting Contacts 

Private User contacts can be imported from and 

exported to other contact databases such as 

Outlook, ACT!, Goldmine and Excel.  When 

contacts are imported, the contact records are 

placed in the Private group and can be moved to 

a different group as desired. 

 

To import contacts from ACT!, Goldmine, Excel 

or Phontage: 

1. Select Import Contacts from the Tools 

menu. 

2. Select the database type. 

3. After importing, the Import Result 

window displays and the imported 

contacts are displayed in the Private 

group. 

 

To import contacts from Outlook: 

1. Select Import Contacts from the Tools menu. 

2. Select Outlook 

3. Select the Outlook contact folder, the Outlook access 

popup displays. 

4. Check Allow access 

for, select a time 

and click Yes. 

5. The Import Result 

window displays 

and the imported 

contacts are displayed in the Private group. 

Note: If No is selected in the Outlook access popup window, 

the import will fail and you will receive an unknown error notification. 
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To import contacts from a CSV file: 

1. Select Import Contacts from the Tools menu. 

2. Select CSV. 

3. Select the CSV file to import.  The CSV Field 

Mapping Table window is shown. 

4. Arrange the CSV Fields. 

5. Uncheck fields not to import. 

6. Click the Import button. 

 

 

 

 

 

To export contacts to ACT!, Goldmine, Excel, Phontage or 

CSV: 

1. Select Export Contacts from the Tools menu. 

2. In the popup Notification window, select Yes to 

include Shared User contacts or No to export Private 

User contacts only. 

3. Select the database type.  The export process starts 

and a notification window appears when completed. 

 

Note: When using Excel reporting, the Excel program must be closed 

before starting to export data.  If the program is not closed, the user 

will receive a popup message requesting Excel to be closed. 

 

To export contacts to Outlook: 

1. Select Export Contacts from the Tools menu. 

2. In the popup Notification window, select Yes to include Shared 

User contacts or No to export Private User contacts only. 

3. Select Outlook for the database type. 

4. Select the desired Outlook contact folder, Outlook access 

popup displays. 

5. Check ‘Allow access for’, select time, and click Yes.  The 

export process starts; a notification window displays when 

completed. 
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7.2 Phone Window View 

With the Phone mode enabled, refer to see Section 

4.1.3.2, you have access to all of the iPECS system 

features as well as the features available to traditional 

iPECS IP Phones, with the few exceptions based on the 

differences discussed below.  The fixed feature keys 

operate in the same manner as in the iPECS IP Phones 

except the mouse is used to select dial pad and feature 

buttons.  For operation of the features, refer to the 

iPECS IP Phone User Guide.  

 

With the exception of the following User Programming 

items, the Phone window screen allows complete access 

to all the features and resources of the System.  

 Station Answer mode – only Privacy for the Station Answer mode; Intercom Call Announce 

is not supported for the UCS Client. 

 Station Ring Download – UCS Client users can change the ring tone files stored in the 

iPECS UCS Client folder; ring tone files cannot be downloaded from the iPECS system. 

 Audio source control – UCS has a single audio path, and cannot support the dual path 

(headset and speaker) controls available with the traditional iPECS IP Phone. 

 

There are three Speaker volume settings for ring, internal call volume, and external call volume; the 

three volumes are saved and retrieved according to phone status. 

 

7.3 Logs Window 

The Logs window displays the log of UCS services 

used by the UCS Client.  The log identifies the 

service type, name of connected party and time the 

service was employed.  These logs are stored on 

the UCS Client PC and can be searched or 

archived as a backup file in the UCS Client folder.  

In addition, by right clicking on a record, the 

popup menu similar to the Presence popup, see 

Section 7.1, is displayed. 

 

Services logged are: 

 Call (Incoming, Outgoing, Conference Room) 
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 Instant Messaging (IM) 

 Application Sharing 

 Desktop Sharing 

 Whiteboard 

 Video 

 Presentation 

 Remote Monitoring (Requesting) 

 Remote Monitoring (Be requested) 

 Web Push 

 File Send 

 SMS 

 Note 

 Missed Call 

 Memo 

 

To search the Logs window: 

1. Select the Service Type from the drop-down menu. 

2. Enter the appropriate text to search. 

 

Note: If more than 2000 records are stored when you login, a Backup window will display indicating 

the Logs window should be archived.  This is needed to minimize any affect of a large number of logs 

on performance of the UCS Client and other Windows applications.  The archive file is named and 

saved to a backup directory in the UCS client folder.  The backup file name includes the date as in the 

following example, 20080325143309092.xml 

 

To view the backup file, double 

click the file name in the UCS 

Client folder and the file is 

displayed with the default 

browser as below. 
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Icon tools

menu

Call & status 

Audio controls

 

7.4 Active Call Window 

When you place or answer a call, the active 

Call tab will display and, if enabled, the 

Call window displays.  The window 

includes call and status information, an icon 

menu and audio controls as shown. 

 

 

 

 

 

7.4.1 Icon Tools Menu 

The Icon tools include the call transfer icon and icons to activate a collaborative session. 

 

To transfer a call: 

1. Select the Transfer icon. 

2. Select a member from the Select Member window and 

then Click OK, 

OR 

3. Select a member from the Popup menu of the user 

Favorite Contacts (refer to Section 9.8). 

 

To add a new member to a Conference Group call: 

1. Select the Add Member icon. 

2. Select a member from the Select Member window. 

3. Click OK. 

Note: This function may require a conference bridge in the call server. 

 

The remaining icons establish collaborative sessions with other users.  To use an icon: 

1. Select the icon. 

2. Select a member from the Select Member window. 

3. Click OK to initiate the session. 

 

The drop-down arrow accesses additional options including Web push and Send Email.  In addition, 

the UCS Client incorporates a tool to play recorded wave files during a conversation so that the 

connected parties can hear the recording.  The wave file can be a recording of a previous 
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conversation, see Section 7.4.3 or any wave file with the following format. 

 

  Wave file format: 

 PCM - u-law or A-law format 

 Bits per sample – 8/16 bits per sample 

 Sampling rate – 8, 11, 16, 22, 32, 44 or 48 KHz 

 Mono or stereo 

 

To playback a wave file: 

1. To play a recorded wave formatted file. 

2. Select Play back a wave file. 

3. In the popup window, select the file type, file 

name and select Play the file to other(s). 

4. Select Stop Playback to stop the playback at 

any time. 

 

 

 

 

 

 

 

 

 

 

 

7.4.2 Call and Status 

Call and Status shows call status as well as the connected 

party’s picture, presence and video status.  The left click 

popup menu offers tools for collaborative sessions, directory 

information on the contact and the contact’s schedule for the 

day. 

 

Note:   indicates a non-registered user. 
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7.4.3 Audio Controls 

The Call window includes audio controls to adjust the speaker and microphone volumes and mute the 

microphone.  In addition, a control is provided to record the current conversation.  Caution, 

recording may not be legal in some locations and other parties should be notified of your intent to 

record a conversation. 

 

To adjust the volume: 

1. Click and slide the volume knob for the microphone or speaker; left is down right is up. 

2. When AGC is on (Section 4.1.3.3), the microphone volume is adjusted automatically by the 

UCS Client.  In this case, you cannot adjust the microphone volume. 

 

To mute the microphone: 

1. Click Mute; the button will light when muted. 

2. Click Mute again to activate the microphone. 

 

 

 

 

 

To record an active conversation: 

1. Click Record; the button will light. 

2. Click Record again to stop recording; the UCS 

Client sends a single “record-start” tone when 

recording is started. 

 

 

 

7.5 Selected Contact Window 

The Selected Contact window displays immediately below the main window and provides basic 

information about the highlighted contact.  

The window includes icons to establish a 

collaborative session with the contact.  

Highlighted icons indicate the communication 

modes available to the contact.  Selecting an 

icon initiates the communication.  The Selected Contact window can be disabled if more space is 

desired in the main window, see Section 4.2.1. 
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7.6 Organization Window 

The Organization window displays 

the Organization Chart from the 

UCS Server in a split screen 

showing the Organization hierarchy 

tree and organization members.  

Members are shown in a tabular 

format with presence status.  

Tools allow the user to customize 

the view with the organization tree 

to the left, right, above or below the 

member table.  In addition, the 

various presence states (IM, phone, video, etc.) can be eliminated from the view and a sorting order for 

the members (IM, Phone or Name) can be selected.  Manual and immediate refresh buttons (     ) 

permit the user to refresh the display immediately or allow timed updates. 

 

To use the Organization window, the Organization Chart must be 

established and use authorized by the UCS administrator.  To 

view the Organization window: 

1. From the View menu, select Organization. 

2. Logout of the UCS Client and log back in; the 

Organization tab will be shown in UCS Client 

automatically. 

 

7.6.1 Searching the Organization Chart 

A department may be selected to view all the users in a 

department.  In the upper right of the Organization window is 

the Search text entry box.  To search for a particular user, 

enter search characters in the box and matching entries will be 

shown in the Organization window.  You may right click on a 

contact to receive popup menus as with the Presence window, 

Section 7.1. 

 

 

Note: The UCS Client will search for a match in the Name, Desktop Phone, User ID and Cellular 

Ericsson-L 
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Ericsson-L

Ericsson-LG

Ericsson-L

Ericsson-LG

Top/Bottom View Bottom/Top View

Left/Right View Right/Left View

Phone fields, in order. 

 

7.6.2 Window Appearance 

Tools in the Organization window allow the user to change the appearance of the window as well as 

the presence information shown for each contact.  To view modify the appearance,  

1. Select the Screen tool at the upper left. 

2. From the Screen tool menu, select the desired screen orientation.  

The Organization window will display with the orientation 

selected. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To modify the presence information shown in the window, 

1. Select the Screen tool at the upper left of the window. 

2. From the Screen tool menu, select Customize Column View. 

3. In the popup menu, check the box in front of each item to 

display for the contacts. 

 

 

To change the sorting of the window, 

1. Select the Screen tool at the upper left of the window. 

2. From the Screen tool menu, select Sort. 

3. In the popup menu, click the sorting column. 
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8. Quick Call Control Bar 

With the Quick Call Control Bar at the 

bottom of the main window, you can make 

and receive calls.  The text box displays 

the names and numbers from contacts in the 

Presence window or you may dial a 

number from the Simple dial pad popup.  

This control bar consists of the Simple dial 

pad icon, drop down contact list, and Call 

and Speaker controls. 

 

8.1 Placing a call 

Placing a call from the Quick Call bar is quick and efficient.  For your convenience, calling options 

are available using the control bar.  

 

To place a call using the Simple dial pad popup: 

1. Launch the simple dial-pad popup using the 

dial pad icon. 

2. Click on digits to select the appropriate 

number, which will be displayed in the pre-

dial box. 

3. Press the Call button to place the call. 

 

To place a call using the drop down contact list (shows a list of contacts from the Presence window): 

1. Click on the drop down arrow to access the contact list. 

2. Click to select the desired number.  

 

To end the call: 

1. Click on the speaker button. 

 

Calls can be placed from other applications while the UCS Client is active or minimized.  To place a 

call from another application:  

1. Copy the desired digit string (Ctrl + C). 

2. Press the “Ctrl + Shift + D”. 

Or 

3. With the Call Assistant displayed, drag the mouse over a number while holding the right 

mouse button. 

Dial Keypad 
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8.2 Receiving a Call 

When a call is received, the phone will ‘ring’ and the selected caller id popup will appear.  The 

window shows the caller id delivered from the iPECS and the name associated from the Presence 

window.  If the UCS Client is minimized, the popup will display the incoming call information or the 

iPECS UCS Client icon in the Windows tray will flash to indicate the new call.  In the later case, 

iPECS UCS Client must be activated to answer the call.  

 

To answer a call with the UCS Client active: 

1. Click on the speaker button. 

 

To answer the call with the iPECS UCS 

Client minimized: 

1. From the Caller Id popup, click the 

Answer button. 

 

 

 

To end the call with the iPECS UCS Client 

minimized: 

1. Click the Drop button. 

Or 

2. Activate the UCS client and click 

the speaker button. 
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9. Tools Menu Call Features 

From the Tools menu of the main application, you can access the Call menu.  In this menu are tools 

designed to enhance group collaboration and simplify use of calling features. 

 

9.1 Group Call 

With Group Call, a conference can be setup with a group by a single call.  iPECS processes the group 

call request by notifying the group members, who can then respond by entering the call or rejecting the 

request.  The UCS Client can add or delete members during the group call with up to 32 members in 

the group call.  Note for proper operation, the iPECS must be equipped with the conferencing module. 

 

To initiate a group call: 

1. From the Tools menu, select Call. 

2. Select Start Group Call from the Call menu. 

3. Add members from the Select Member 

window.  Members are added from the 

 Presence list 

 Shared directory 

 Manually entered telephone number 

4. The selected or inputted numbers are displayed 

in the Added Member List at the bottom of the 

window. 

5. Press OK, members of the group are notified of 

the request. 

 

To join a group call: 

1. When the Group Call .popup is received, click 

Yes. 

 

To add members to an active group call: 

1. Click the Add User icon. 

2. Select new members (up to 32) from the Select 

Member window. 
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To delete members from an active group call: 

1. Click the down arrow to the right of the record of the 

member to be deleted. 

2. From the popup menu, select Remove this from Group Call. 

 

9.2 Conference Room 

iPECS UCS Client can use the iPECS Conference 

Room feature to set-up or join a scheduled 

conference.  A Conference Room can support up 

to 32 parties with the iPECS conferencing module.  

When accessed, the Conference Room window 

displays controls to create and manage rooms and 

status of available rooms.  The status is indicated 

with icons as below: 

 

 Vacant Room 

 Created Room 

 Room in use 

 

To access the Conference Room window: 

1. From the Tools menu, select Call. 

2. From the Call menu, select Conference Room, to display the window. 

 

To update the status of rooms: 

1. Click the Refresh button. 

 

To enter a room: 

1. Click the Enter button. 

2. Enter the room from the Conference Room window. 

3. Enter the Access Code from the room creator. 

 

To create a Conference Room: 

1. Select a vacant room from the window. 

2. Enter an Access Code, maximum 5 digits. 

3. If desired, check Send Email to send an e-mail 

notification of the conference. 

4. Click OK to create the Conference Room. 
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To delete a Conference Room: 

1. Select the room from the window. 

2. Click the Delete button. 

3. Enter the Access Code. 

4. Click OK to delete the room. 

 

9.3 Scheduled Dial 

Scheduled Dialing permits you to enter a 

phone number for dialing at a later 

scheduled time.  When the scheduled time 

is reached, the Confirm window appears, 

you must confirm before dialing will begin.  

The Scheduled Dial window contains a list 

of the phone numbers and schedules 

entered.  The window includes icon tools 

to manage scheduled calls.  

 

To access the Scheduled Dial window: 

1. From the Tools menu, select Call. 

2. From the Call menu, select Scheduled Dial to display the window. 

 

To add or edit a Schedule Dial: 

1. Click the Add or Edit icon on the 

Scheduled Dial window; the Schedule 

Dialing Manager popup appears. 

2. Enter the Name and Company. 

3. Enter or use the drop down menu and 

select a Phone number (required entry). 

4. Use the pull-down to schedule a Date & 

Time.  

5. Click OK to save. 

Note: Each Schedule Dial must have a unique scheduled time.  Duplicate schedule times are not 

allowed. 

 

To delete an entry from the Scheduled Dial window: 

1. Select Delete or Delete All; confirm the record deletion. 

2. Click OK. 
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Note: When the scheduled time is reached, the 

Confirm window will appear.  You must confirm by 

selecting OK before dialing will begin.  You can 

select snooze to delay the call. 

 

 

 

 

 

9.4 Recorded Call Playback  

The UCS Client allows you to record a conversation onto the client PC hard drive.  Recorded 

conversations can be reviewed after recording.  In addition, text or voice comments can be added to 

the recording and sent via email as attached .wav files.  Using the tool icons at the top of the Recorded 

Call window, you can delete, add a comment and e-mail recordings.  

 

Calls are recorded from the Call window, see section 7.4.3.  To playback a recorded call: 

1. From the Tools menu, select Call. 

2. From the Call menu, select Recorded Call to display the Recorded Call window. 

3. Select the desired recording. 

4. Use the reverse, play, pause, forward and stop playback icons to control the playback. 

 

9.5 Auto Call Recording 

When enabled in the iPECS system, conversations of the UCS Client and/or other 3
rd

 party iPECS 

users are recorded to the hard drive of the UCS Client PC.  Automatic recording is assigned under 

Program code 112 of the iPECS-LIK system.  Other stations in the system may be assigned to record 

conversations to the UCS Client, “3
rd 

party recording”.  For proper 3
rd

 party recording, the iPECS 

UCS Client must be idle. 

 

Once recorded, the Recorded Call window (refer to Section 9.4) will indicate the date, time and station 

number(s) that was party to the conversation. 



ECS       UCS Client Installation & User Guide 

 

 60 iss.3.1 

 

9.6 Flex Buttons 

The Flex Button window provides access to 48 Flex buttons.  

Each button includes a status icon, which displays the status 

of the CO Line or station associated with the button.  The 

button also displays a designation from the iPECS system 

database, such as CO 001, LOOP, etc.  When used with an 

iPECS LIK, Flex buttons of the UCS Client can be assigned 

to dial a Station Speed Dial. 

 

To enter and assign a Station Speed Dial to a Flex button: 

1. Right click on an assigned Flex button. 

2. Select Set Attribute; the Flexible Button program screen will display. 

3. Enter the number to be dialed. 

4. Click the CO Call checkbox if the input number is not a station number. 

5. Enter an optional Description (display) label for the Flex Button. 

6. Click on the Save button. 

 

Note: If a Flex button is assigned for Paging, the UCS Client must be off-hook prior to selecting the 

Page button.  The UCS Client must be in the idle mode to assign a Flex button. 

 

9.7 Voice Mail Server Selection 

When multiple voice mail servers are associated with the 

UCS Client, the VM Selection window permits access to the 

various mail servers. 

Note: A server can be selected as default, in which case this 

window is not shown when selecting the VM icon in the 

Message and Status icon tool bar. 

 

To access the VM Selection window: 

1. From the Tools menu, select Call. 

2. From the Call menu, select VM Selection to display the VM Selection window. 

3. Select the desired voice mail server from the drop down list. 



ECS       UCS Client Installation & User Guide 

 

 61 iss.3.1 

 

9.8 Favorite Contacts 

Favorite Contacts allows the user to call and transfer calls 

easily using the Call window. 

 

To add lists to Favorite Contacts: 

1. From the Tools menu, select Call>Favorite 

Contacts>Favorite Contact, the Select Member 

window will be shown. 

2. Select the desired Member(s) and press the Add 

button.  The contacts are added into the bottom 

of the Select Member window. 

 

 

9.9 Step Call 

Step Call allows the user to make calls to numbers 

from a contact list sequentially.  Users create a list 

of contacts for outbound calling, which can be added 

one-by-one or imported from a file where the file 

extension is ‘.scd’ or ‘.csv’. 

 

To add contact(s) to an outbound calling list using the 

Add button on the toolbar: 

1. Click the Add button in the toolbar. 

2. Enter values into the edit box at the bottom 

of the Step Call Information window. 

 

 

 

To add contact(s) to an outbound calling list by downloading entries 

into the Step Call Database from a .scd, .csv formatted file: 

1. From the File menu, select Load Step Call Database. 

2. Select a Step Call Database. 

 

Note: User can create a Step Call Database template file with a file extension of .csv (select 

File>Create a Template File). 
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To add contact(s) to an outbound calling list from the Directory: 

1. From the File menu, select Add List from Directory, the 

Select Member window will be displayed. 

2. Select and add the desired contact(s) from the Select 

Member window. 

 

To make an outbound call using Step Call: 

1. If you do not want to receive calls during the Step Call, activate ‘DND’. 

2. Select a record in the outbound calling list. 

3. Press the Step Call Start button  

4. The phone number of the selected record will be dialed. 

5. After the call is completed, the ‘Result’ and 

‘Memo’ can be created by the user as 

necessary; the interval between calls is set as 

shown. 

 Result input selections include: 

- Success  

- Failure . 

 If a memo is saved, thesymbol will be displayed.  

 If  is pressed, the current time and user name will be entered automatically.  

The next record on the list will be selected automatically. 

6. Step call will be stopped when the end of the calling list is reached, 

OR 

7. Step call can be stopped by pressing the  button. 

 

Alternate method for making a Step Call: 

1. Select a record from the outbound calling list. 

2. Press the Make a Call button ( ); the call will be initiated. 

3. When the call is terminated, the user can enter the ‘Result’ and ‘Memo’, if necessary. 

 

To end a Step Call: 

1. Press the ‘Drop’ button ( ). 

 

To create a Template File: 

1. From the File menu, select ‘Save the current List As…’. 

2. In the dialog box displayed, enter the desired file name and click on the OK button. 

3. A .csv file will be created with the designated name. 
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To use the created Template file: 

1. Open the template with ‘Excel’, ‘Notepad’, etc. 

2. Enter values (Name, Company, Department and Phone number). 

3. When finished, click Save. 

4. Refer to Load Step Call Database (.scd, .csv) above to download the file. 

 

To save the current Calling List to a file: 

1. From the File menu, select ‘Save the current list As…’. 

2. In the dialog displayed, enter the desired file name. 

3. Click the OK button. 

 

 

To send the current Calling List to others: 

1. From the toolbar, select File Send. 

2. The UCS Client will save current list as a temp file and attach it to ‘select file’ of the File 

Send window. 

 

9.10 Call Memo 

The Call memo is designed for noting important information 

during a call so that the information can be referenced at a 

later time.  The call memo is retained in the recent Logs.  

Also, a user can confirm and modify the memo in the Call 

Memo window.  The following methods can be used for 

activating the Call Memo window: 

 

1. From the File menu, select Setting>Call 

Popup>Show Call Memo Window Automatically. 

2. When a call is placed, the Call Memo window will 

automatically display. 
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To activate the Call Memo window from the Call Tab: 

1. Click on the Call Tab when on a call in UCS client. 

2. Select ‘Add Call Memo’ or ‘Show call memo’. 

 Add Call memo –a call memo can be added 

with CID information. 

 Show Call memo – displays call memos 

already created. 

 

To activate a Call Memo window: 

1. If the option ‘Call pop-up’ is set and the UCS 

Client has Call memos regarding the current 

call, the Call Memo window can be activated 

by clicking on the icon at the bottom-right of 

the call pop-up window. 

Note: Prior to closing the Call Memo window, the memo content is summarized on the screen. 

 

To add a new Call Memo: 

1. Open the New Call Memo area. 

  Open this area. 

  Close this area. 

2. Enter the memo contents. 

3. Click on the Add button. 

4. The saved memo will be located in recent Logs, and can be viewed when a call is placed from 

the UCS client. 

 

Using Scheduled Dial: 

1. Verify the ‘Scheduled Dial’ checkbox is checked.  

2. Click on the Add button. 

Note: the schedule dial will be activated with the user name, phone number and company name in the 

Call Memo; saved Call Memos also will display in this area, and can be modified or deleted. 

 

To modify a saved Call Memo: 

1. Click on a call memo to be modified; the call memo will be opened for editing. 

2. Modify the content. 

3. Changes will immediately update in the Call Memo. 

 

To delete a registered Call Memo: 

1. Select the Call Memo. 

2. Click on the Delete button. 
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The Call Memo tab can be used to manage comments from multiple users such as during a conference 

call.  Each user is separated with a tab on the Call Memo window. 

 

To Close a Tab: 

1. Click on the Close button,    , within the appropriate tab. 

Note: if only one tab is open, the close button will not be visible. 

 

To select a different opened tab: 

1. Click on another tab to add call memos for others on the call; changes are saved and displayed 

in a new Call Memo window. 
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10. Scheduling Appointments 

In the Schedule window, 

you can view, add and 

modify scheduled 

appointments.  

Appointments can be 

viewable by and e-mailed to 

other UCS Client users.  

Appointments are displayed 

in the Schedule window, 

which is divided into 4 main 

components.  At the top of 

the window are the 

appointment management 

icon tools.  In the upper left is the monthly appointment calendar, used to select appointment dates.  

In the lower left is the folder selection area used to select appointment folders to display in the 

Appointment window.  Finally, the Appointment window displays the summary appointments top 

portion and details of the selected appointment at the bottom of the window. 

 

The Schedule window can be accessed from the main application Tools menu or by clicking on the 

calendar icon to the right side of the My Detail Information. 

 

10.1 Managing Appointments 

You can add, modify, delete and copy your private appointments or shared schedule appointments in the 

Schedule Item window.  For your private schedules, you have all access right to read, add, modify, 

delete and copy appointments..  For shared schedules, you can read all appointments but, you may 

have the authority to add, edit and delete Shared schedules as well as your private schedules.  In this 

window, the appointment is identified, scheduled and other users identified for notification.  In 

addition, a location and meeting content can be defined. 

 

To add an appointment:  

1. Select a date in the monthly calendar and click on the Add icon to display the Schedule Item - 

New window. 

2. In the Schedule Item window, complete all required fields. 
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 The Subject and Location fields can be a 

maximum of 255 characters. 

 Contents field can be a maximum of 450 

characters. 

 Up to 20 attendees can be listed and each must 

have unique e-mail addresses.  

3. Set the action for automatic My Presence update for 

this appointment.  UCS Client will change and 

return My Presence to the status selected from the 

My Presence for an Appointment and My Presence 

After Expired fields. 

4. Click OK; the new schedule will be displayed on the 

calendar. 

 

If the ‘Send Email Now?’ box is checked, the schedule is 

added and your default email client opens with the attendees listed as receivers and the schedule 

attached.  If MS Outlook is set as the default email client, ‘New appointment’ is displayed instead of 

‘New email’. 

 

Note: When there are several appointments that change My Presence at one time, the lower schedule in 

the today’s appointments list has higher priority. 

 

Other UCS Client users can view your private schedules when you allow it by checking the Open This 

Schedule to All Shared Users box.  If you check this box, other UCS Client users can view your 

schedule and use it for presence information.  If the 

date of the appointment is today, your presence member 

can see that you have an appointment today as shown. 

 

Also, you can allow other UCS Client users to view all your private schedules by checking the popup 

menu of your private schedule folder. 

 

If you want to arrange the schedule with 

attendees, click Others button, a, popup menu 

appears where you can start an IM session, 

Make a Call or check attendee schedules. 
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To view an attendee schedules: 

1. Click the Add icon. 

2. Select Attendees for the schedule using the 

Select Member window. 

3. Click the icon of another user; the popup 

menu will display. 

4. Click on a particular Attendee’s Schedule 

Viewer; the Viewer will display. 

 

 

 

5. If the start date and end date of the 

appointment are the same date, the window 

will show the day’s schedule of all attendees.  

Otherwise, it will show the day period 

schedule. 

 

 

 

 

 

To edit a schedule: 

1. Double click on the appointment in the Appointment 

window or select the appointment and click the 

highlighted Edit icon. 

2. Select the Edit icon button to  display the 

Appointment window 

3. Modify the information in the window, see Adding 

an appointment above. 

4. Select OK, the modified appointment is displayed in 

the appointment list. 

 

Note: When you edit an appointment that changes My 

Presence, you cannot select options from My Presence for an 

Appointment and My Presence After Expired drop-down list. 

 

To delete an appointment: 

1. Select the appointment from the Appointment window; if you have permission to delete the 
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appointment the Delete icon will highlight. 

2. Click the highlighted Delete icon. 

3. Confirm to complete the deletion. 

 

Note: When you delete the appointment that changes My Presence, a confirmation window will 

display.  If you click ‘Yes’ button, My Presence will be changed by the My Presence After Expired for 

the appointment. 

 

To copy a schedule to another date: 

1. Select the appointment from the Appointment window; if you have permission to edit the 

appointment the Edit icon will highlight. 

2. Select the highlighted Copy icon to display the Copy Schedule popup. 

3. Input any appointment edits and select new dates; the start and end dates and time are required 

fields. 

4. Select OK, to copy the appointment. 

Note: If the difference between start and end date exceeds 7 days or if the range includes selected 

appointment dates, an error message displays. 

 

An ICR scenario can be added to a schedule to be used as needed for routing incoming calls at 

designated times. 

 

To add an ICR scenario for a schedule: 

1. Right-click on an appointment where the ICR scenario will be added. 

2. Select Add ICR Scenario; the ICR Wizard window will display. 

3. Enter Scenario Name and assign a scenario destination (refer to Section 11.4.5). 

4. Click on the OK button. 

 

To remove an ICR scenario from a schedule: 

1. Right-click on the appointment containing the ICR scenario. 

2. Select Remove ICR Scenario. 

3. Click to confirm the deletion. 

 

10.2 Folder List Display 

iPECS UCS Server maintains two lists of schedule folders, a shared schedule and your private 

schedule folders.  Schedules in the shared folder are managed in the UCS Web Administration by 

allowed users only.  Schedules in My Folder are your private schedules, which you maintain and 

manage.  Appointments from the selected folders are shown in the Appointment window.  To select a 

folder check the box next to the folder name. 
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For each day, the window shows the appointments for all checked folders organized by date.  The list 

for each date can be minimized or expanded to display the summary. 

 

10.3 Importing and Exporting the Calendar 

The appointments for the current month contained in a schedule folder and displayed in the calendar 

can be imported from or exported to Outlook.  If you want to import or export schedules for other 

months, simply change the month displayed in the calendar.  Items contained in an unchecked 

schedule folder cannot be imported or exported.  Also, shared schedules not managed by you cannot 

be imported to or from your shared schedule folder. 

 

To import a schedule: 

1. Right-click on a checked schedule folder. 

2. Select Import From Outlook. 

3. Select the Outlook schedule folder to import and click 

OK; the Import from Outlook window will display. 

Note: The Recurring column indicates that it is a recurring 

appointment. 

 

 

 

 

 

 

 

 

4. Select each checkbox for the schedules you want to import. 

5. Click on the Open checkbox of other UCS Client schedules that you want to view. 

Note: If Open All Schedule to Shared Users is unchecked in the personal schedule settings, the 

Open column of Import from Outlook will not appear. 

6. Set the action for automatic My Presence change for this appointment.  The UCS Client will 

change and return the My Presence selected from the Presence Update and When Expired 

drop-down list.  When finished making selections, click Import. 

7. The Import status displays in the Result column of the Import from Outlook window. 
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Note: If imported appointments contain text in HTML or Rich Text format, the text will be displayed in 

plain text format. 

 

To export the contents to Outlook: 

1. Right-click on the checked schedule folder that will be exported. 

2. Click Export To Outlook; the Export To Outlook window displays. 

3. Click on the checkbox for the schedules to export. 

4. When finished, click the Export button; the Folder Selection window displays. 

5. Click on the target Outlook calendar folder to receive the export. 

6. Click OK to export the schedule, updating Outlook schedules. 

7. Export status displays in the Result column on the Export to Outlook window. 

Note: Recurring appointments cannot be exported to Outlook because of the applicability of 

existing appointments. 

 

10.4 View Other UCS Client User Schedules 

You can check other UCS client user schedules if the schedules are enabled for viewing by checking 

the Open This Schedule to All Shared Users box.  To find UCS Client Schedules available, click on 

all selections: Presence, Organization, Logs and Call windows in the main window or Search Shared 

User window. 

 

To view other UCS Client user schedules: 

1. Right-click on a contact’s schedule. 

2. Select Schedule Info; the Schedule Info 

window will display. 

3. Select the month to view by navigating 

forward and backward from the current 

position using the arrow buttons in the 

upper-left part of the window. 

4. Select a date in the mini-calendar on the 

left side. 

5. Click on the schedule, and the detail 

information will display on the bottom 

portion of the screen. 

6. Click OK to close the window after viewing the schedule. 
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11. ICR (Individual Call Routing) Window Introduction 

With iPECS UCS Client, you can 

establish scenarios to route 

incoming calls.  Each scenario 

defines rules to route incoming 

calls, time, day of week, date and 

caller ID to a destination you define.  

Up to 10 scenarios can be 

established using the UCS Client 

ICR Wizard and the relative priority 

of each can be set.  Also, you can 

select another UCS Client user as 

an Agent, who is then able to view and modify your scenarios.  When an incoming call is received, the 

iPECS notifies the UCS Server, which queries your ICR scenarios.  iPECS UCS Server will compare 

the incoming call parameters to those of the scenarios.  The call is then routed to the destination in the 

matching scenario with the highest priority. 

 

The ICR Scenario window consists of three (3) major components: the User list on the left the Scenario 

and Summary screen on the right and the ICR icon tools at the top. 

 

To access the ICR window: 

1. Click Set My Phone Status from the File menu or the Phone status 

icon from the main window 

2. Select Call Forward (ICR) from the menu. 

 

The following sections discuss the components of the ICR window, and how to establish and activate 

ICR scenarios. 

 

11.1 ICR User List 

The User list, left side of the window, displays a list of scenarios accessible by you.  In addition to 

your own scenario (default=Myself), you may be the registered as an Agent for other iPECS UCS 

users.  This permits you access to scenarios of those users.  Selecting a user from the list displays the 

corresponding scenarios. 
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Note: The  icon represents your 

scenario list and, the  icon represents 

scenarios of users that registered you as 

an agent. 

 

 

 

 

11.2 Scenario & Summary Screen 

The Scenario & Summary window is a list of scenarios for the selected user and a summary of the call 

parameters for the scenario.  In this screen, the priority of the scenario can be adjusted with the 

up/down arrows.  The scenario listing includes: 

 Act – check box shows the status of the scenario (checked is active). 

 Index – defines the priority of the scenario. 

 Scenario Name – name assigned to the scenario. 

 Comment – timing status of the scenario: 

- Effective – timing of scenario is active or future, 

- Expired – timing of scenario has expired. 

 Holiday – indicates the scenario is for a holiday schedule. 

 Schedule – indicates the scenario is from your schedule 

 

The Scenario Summary at the lower part of the window displays the call parameters for the highlighted 

scenario: 

 Caller ID – Caller ID or Phone number that applies to the scenario. 

 Date & Time – the day, date and time to apply the scenario. 

 Destination – the destination User ID or Phone number. 

 IM Presence Condition – the IM presence state that applies to the scenario. 

 

To adjust the priority of a scenario: 

1. Select a scenario in the list. 

2. Select up/down arrows to move the 

scenario in the list. 

3. Click Save to store the new priorities. 
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11.3 ICR Icon Tools 

The ICR icon tools are used to manage the User Scenarios.  Icons refresh the ICR window and save, 

add, or edit scenarios.  

Using the CFWD icon, 

you can forward your 

traditional iPECS 

terminal using a scenario.  

Finally, with the My 

Agent icon, users can register or delete their Agent definition.  The following list identifies the icons, 

and provides a reference for more detailed information on operation of the icons (as applicable).  

 

  refreshes the user list (refer to Section 11.1). 

  refreshes the displayed scenario list. 

  saves the scenario. 

  adds a new scenario (refer to section 11.4). 

  edits the selected scenario (refer to section 11.4). 

  activates ICR Call Forward for the user’s iPECS terminal (refer to section 11.5). 

  registers or deletes agent (refer to section 11.6). 

 

11.4 ICR Wizard 

The ICR Wizard guides you through setting the parameters for a scenario.  In the wizard, you will 

assign a name, the Caller IDs to which the scenario applies, the scenario timing and the destination(s) 

to receive the call. 

 

To access the wizard, select Add or Edit from 

the ICR Scenario List window or select from 

the popup Scenario menu (refer to Section 

11.7).  
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11.4.1 Entering a Scenario Name 

A Scenario Name with the current date and 

time is automatically generated when Add is 

selected.  The name can be modified at any 

time. 

 

To add scenario name: 

1. Enter a name in the Scenario Name 

box. 

 

11.4.2 Defining the Scenario Caller ID 

Each Scenario applies to all calls, only calls 

from specific Callers, or another UCS Client.  

Your Private directory or the UCS Shared 

directory can be searched to select callers, or 

you may directly enter Caller IDs that are 

subject to the Scenario routing. 
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To apply the Scenario to all calls: 

1. Select the All call radial button. 

 

To search both the Presence and Shared 

directory: 

1. Select the Select Call(s) radial button. 

2. Click on the Spyglass icon; the Select 

Member window displays. 

3. Select members to add. 

4. Click OK to add the member. 

 

 

To enter a specific number: 

1. Enter a number in the Call Number to 

Add box. 

2. Select the Add icon to add the number 

to the Caller Id list. 

 

 

 

 

To remove a Caller ID from the list: 

1. Highlight the desired Caller Id(s) by 

clicking on each. 

2. Select the Delete icon. 

 

 

 

 

11.4.3 Setting the Scenario Timing 

You can specify a time period (day, date, and time) when a Scenario will be effective.  You may select 

from several pre-defined periods, Work, Off Time, Holiday or Weekend, or define a timing specific to 

the scenario. 
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To set Scenario timing: 

1. Select one of the predefined times or select 

Time and click Add button. 

2. Select the desired start and end times; check 

the days of the week for the scenario and select 

a start and end date. 

3. Select OK to save update. 

 

 

 

 

 

 

 

 

 

 

 

 

11.4.4 Setting the IM Presence Condition 

You can specify the IM Presence when a Scenario will be effective.  You may make a scenario active 

regardless of IM Presence or select an IM Presence, Offline, Online, Busy, Away, Be Right Back, Out 

of Office or In a Meeting. 

 

To apply the IM Status to a Scenario: 

1. Select the All IM Status radial button. 

 

To apply the Scenario to a specific IM Status: 

1. Select the Selected IM Status radial button. 

2. Select an IM Presence (Offline, Online, Busy, Away, Be Right Back, Out of Office or In a 

Meeting) from drop-down Type menu. 

 

11.4.5 Assigning a Scenario Destination 

The Destination area establishes the routing of calls that meet the parameters of the scenario.  

Destinations include your cellular phone, home phone or office phone already registered.  

Additionally, your Private directory or the UCS Shared directories can be searched or you may directly 
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enter a destination to receive the call. 

 

To search either the Private or UCS Shared directory: 

1. Click the Select Call(s) radial button. 

2. Click to Select User from the drop-down Type 

menu. 

3. Click Search. 

4. Select a destination from the Select Member 

window. 

 

 

 

 

 

 

 

 

 

 

To enter a specific destination: 

1. Check the Select Call(s) button. 

2. Select a Type (Station, Hunt group, Offnet) from drop-down Type menu; a specific Hunt group 

is selected from the list. 

3. Enter the appropriate number in the Selected Call(s) box. 

4. Click OK to save the new or modified scenario(s). 
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11.5 Activating ICR Call Forward 

Once scenarios are saved, the ICR feature can be activated to forward your calls using the scenarios.  

When a call is received, to your iPECS phone number the UCS Server compares the call parameters to 

scenarios and routes the call appropriately. 

 

To activate the ICR Call Forward feature: 

1. In the ICR window, select the Scenario(s) by clicking to highlight. 

2. Click on the CFWD icon tool. 

3. Select the Forwarding Type from the drop-

down menu.  Available choices include: 

 Clear 

 Unconditional 

 Busy 

 No Answer 

 Busy/No Answer 

4. Click on the OK button activate ICR. 

 

11.6 Using My Agent Control 

You can define another UCS Client user as an Agent that can view and modify your scenarios.  You 

can register only one Agent, but can be the Agent for multiple other UCS Client users. 

 

To manage Agent definitions: 

1. Select the My Agent icon; the My Agent popup menu displays. 

2. Select Register My Agent to assign an Agent, 

OR 

3. Select Delete My Agent to remove your Agent. 
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11.7 Scenario Menu 

In addition to the ICR icon tools, the Scenario menu can access the Scenario Wizard.  From the 

Scenario menu, you can add, edit and delete a scenario.  Adding and editing a scenario is discussed in 

Section 11.4 

 

To delete a scenario: 

1. Right-click on a scenario in the Scenario list, 

the Scenario menu appears. 

2. Click Delete; a confirmation window appears. 

3. Select OK to delete the scenario. 
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12. Collaborative Session Tools 

Other collaboration tools include Instant Messaging (IM), Sending files, Sharing, Web Push and Video 

Conferencing.  In conjunction with the Voice and Video communication, a complete multi-media 

communication session involving text and graphic messages, sharing, Web Push, and sending files can 

be established with the UCS Client.  The tools are under the main application Tools menu, in right 

click popups (Presence, Log and Call windows), and the Selected Contact window.  This section 

covers the use of each of the collaborative session tools. 

 

12.1 Instant Messaging Introduction 

IM is an IP-based near real-time communication service for text and graphic information.  You can 

create and send a message to other UCS Client users in the IM session.  Other users can create and 

send responses as they desire.  An IM may be text or a drawing and can be supplemented with 

Emoticons. 

 

An IM session can be created as an ad-hoc session, or a meeting can be established by creating a Chat 

Room.  A Chat Room can be public allowing all UCS users entry, or it can be password protected 

allowing only specific users to enter the room.  Message dialog can be stored locally as a Rich Text 

Format (RTF) file. 

Note: You must be online to initiate, be invited to, or join an IM session. 

 

12.1.1 Initiating an Ad-hoc IM Session 

For an ad-hoc session, the IM window (refer to Section 12.1.3), may be opened from the main window 

Tools menu, as part of an active call or video conference using the IM icon tool.  Once an IM window 

is opened, additional participants may be added using Invite from the IM menu.  Up to six (6) users 

can simultaneously participate in an ad-hoc session. 

 

To start an IM session from the main application menu: 

1. Select IM from the Tools menu, which displays the 

Select Member window. 

2. Select the desired members from the Member List 

area, and click Add to list the member in the Added 

Member List. 

3. Select OK to display the IM window (refer to 

Section 12.1.3). 
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To start an IM session from any of the Main, video or other 

windows or popup menus: 

1. Right-click on an online user; the popup menu will 

display. 

2. Select IM from the popup menu. 

 

 

12.1.2 Creating a Chat Room IM Session 

The Chat Room permits an IM 

session with multiple users at one 

time.  The Chat Room can be Public, 

meaning any user may enter the room, 

or Private, meaning a user must enter 

a password assigned for the Chat 

Room to gain access.  To further 

control entry to a Private Chat Room, 

users allowed access may be defined in the Create Chat Room window.  

 

To create a Chat Room: 

1. Select Chat Room from the main application Tools menu; 

this will display the Chat Room window. 

2. Click the Create icon to show the Create Chat Room 

popup. 

3. Enter the appropriate information to create the Chat Room. 

4. Click on the desired members in the Select Member 

window. 

5. Click OK to finish creating the Chat Room. 

 

Once a Chat Room is created, users may 

enter the room.  To enter a Chat Room: 

1. Click on the desired Chat Room from 

the Chat Room window. 

2. Click the Enter icon. 

3. If the Room is password protected, 

enter the password and click OK. 
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12.1.3 IM Window Introduction 

The IM window is comprised of a number of areas including the IM menu, icon tools, Participant List 

area with Picture IDs, message dialog area and message entry area.  

 

 

12.1.3.1 IM Application Menu 

The IM application menu has the File and Tools selections.  

When ending a session, text from the IM message dialog can 

be saved locally as an RTF file.  To save an IM message 

dialog: 

1. Select Save from the IM File menu. 

2. In the File menu, select Save. 

3. In the popup, select the location and file name. 

4. Click OK to store the file. 

 

From the Tools menu, additional users can be invited to an 

active IM session.  To invite a user to an IM session: 

1. Select Invite from the IM Tools menu, the Select 

Member window displays. 

2. Select the desired members from the Member List area, 

and click the right arrow button to move the members 

to the Added Member List, 

IM application menu area 

Icon Tools area 

Participant List area 

Message entry area 

Message dialog area 
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OR 

3. Members can also be added by dragging and dropping from the Presence window to the IM 

window. 

 

12.1.3.2 IM Participant List 

The Participant List area displays the Picture ID associated with each participant in the session.  

You may display summary information about individual participants and can use collaboration 

tools from the Picture ID. 

 

To access the tools from a Picture ID: 

1. Click the down arrow in the lower-right corner of the Picture ID. 

Note: You can drag a file from the explorer and drop it on the Picture 

ID of a selected contact to send the file to that contact. 

 

 

 

 

 

To display summary information for the associated user: 

1. Click on the Picture ID to display the ID Summary 

popup. 

2. Select Close to close the popup. 

 

 

 

12.1.3.3 IM Icon Tools 

As with other windows, the IM window includes icon 

tools to place a call, start a video conference and tools 

to initiate other collaborative sessions with other 

participants in the IM session. 

 

 

 

12.1.3.4 Sending IM Messages 

With the IM window displayed, you can send and receive messages with text, drawings, Emoticons 

and Web page addresses or a Universal Resource Indicator (URI). 
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As a default, the IM session is set for text messages.  The 

font used can be adjusted and emoticons can be added.  

To send a text message: 

1. If not highlighted, click the Text button on the left 

above the message entry area. 

2. Enter the desired text in the message entry area. 

3. Click on Send to display the message in the dialog 

window and send the message to other participants. 

 

 

 

 

 

 

 

To modify the font: 

1. Select the Font button to the right above the 

message entry area; the font-formatting 

screen will display to change the font, style 

and size. 

 

 

 

 

 

 

To include an Emoticon in a message: 

1. Click on the Emoticon button; the 

Emoticon selection window will 

display as shown below. 
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2. Click on the desired emoticon; it will appear in the message entry screen. 

 

To send an IM message with a drawing: 

1. Click on the paintbrush icon on the 

left above the message entry area. 

2. Click and hold the left mouse button, 

using the mouse as the brush. 

3. Draw the desired image. 

4. Click Send to send the drawing; the message entry area will be cleared. 

 

When the paintbrush icon is highlighted, 

the brush color and size format boxes are 

shown on the right above the message entry 

area. 

 Adjust the color and line thickness 

from the drop-down menu choices. 

 Select Clear to remove drawings from the message entry screen allowing a new drawing to 

be made. 

 

12.1.4 IM Log 

If enabled, each IM sent is stored in the IM Log.  

To enable the IM Log, refer to Section 오류! 참조 

원본을 찾을 수 없습니다..  Only text is saved to 

the log, Emoticons and drawings are not stored.  

The IM Log includes the date, time, sender, and 

receiver(s) of the message as well as the message 

text.  The Log can be searched by any of the 

columns shown in the IM Log window. 
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12.2 File Send Introduction 

iPECS UCS Client users may send files from their PC to other UCS Clients.  Up to three files can be 

sent to up to five selected UCS Clients at a time.  The maximum file size that can be sent is 300MB.  

The receiving UCS Clients must be online and authorize receipt of the file before the file can be sent.  

Received files are stored in the UCS Client PC directory defined in Setting window, refer to Section 

오류! 참조 원본을 찾을 수 없습니다.. 

 

12.2.1 File Send Window 

The File Send window manages the transfer of files from one UCS Client to another.  The window 

includes the list of users (maximum 5) to receive the files and the files (maximum 3) being sent.  

Icons allow you to add or delete recipients and files as 

well as initiate or cancel a file transfer.  The recipient 

list includes a status display indicating the file transfer 

status and the percentage of each file transferred. 

 

To access the File Send window: 

1. Select File Send from the main, video or 

sharing windows, or various popup menus. 

 

To send files from the File Send window: 

1. Click the Add members icon. 

2. Select recipients from the Select Member window (refer to Section 12.2.1.1). 

3. Click the Add files icon. 

4. Select files from the Browse for Folder window (refer to Section 12.2.1.2). 

5. Click on Send, the File column shows the transfer status. 

 

Status indications in the Status column are: 

 Requesting – Indicates the recipient has received the request to transfer files. 

 Allowed – Indicates the recipient has accepted the file transfer and the files are being sent. 

 Denied – Indicates the recipient has rejected the file transfer and the files are not sent. 

 Failed – Indicates no response from the recipient or an error occurred 

 Completed – Indicates the file transfer has been completed. 

 Canceled – Indicates the recipient has cancelled the file transfer. 

 



ECS       UCS Client Installation & User Guide 

 

 88 iss.3.1 

12.2.1.1 Adding Member Recipients 

When you select the Add member icon, the Select 

Member window displays.  From this window, you 

may select members to receive files.  A user must be 

online to be selected as a recipient.  To select users 

to receive files: 

1. Select recipients from the Member List. 

2. Click on Add to move members to the Added 

Member List. 

3. Click OK to add the users as recipients and 

return to the File Send window. 

OR 

4. Recipients can also be added by selecting them 

from a main window then drag and drop them 

to the Select Members list in the File Send 

window. 

 

12.2.1.2 Adding Files to Send 

When you select the Add files icon, the Open window displays.  From this window, you may 

browse folders in the PC to locate the files you wish to send. 

 

To select files to send: 

1. Select the Add icon. 

2. Browse to locate the appropriate files 

on your PC. 

3. Select the desired file, and click OK to 

add the file to be sent. 

OR 

4. Files can also be added from a directory 

screen by dragging and dropping to the 

Select File area of the File Send 

window. 

 

12.2.2 Recipient Authorization 

When you select Send in the File Send window, recipients receive a 

popup notification that another user is attempting to send files to them.  

The popup lists the name of the user attempting to send files.  The 

recipient may accept or reject the file transfer.  If the invited user 
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accepts the file transfer, the File Send window displays and both the sender and receiver see the file 

transfer progress.  If the recipient rejects the transfer, your File Send window will show the file 

transfer status as denied and files are not sent. 

 

12.2.3 Opening Received File 

When files are received, they are stored in the directory defined under Section 오류! 참조 원본을 

from 찾을 수 없습니다..  The files can be opened immediately 

the File Receive popup, using the normal PC file open 

sequence or from the UCS Client File menu: 

1. Select Open Received Files from the File menu. 

2. Double click on the desired file. 

 

 

 

 

 

 

 

 

 

 

 

12.3 Application Sharing 

The application sharing function permits iPECS UCS Clients to share the information displayed in the 

Sharing Master Page with up to five (5) other UCS Client users.  You can share documents, 

spreadsheets, presentations and drawings in real-time.  The initiator or master maintains control of the 

shared material and can edit the material, which is immediately shown to other UCS Clients in the 

sharing session.  The master can pass control to another user in the session, permitting the new master 

full session control. 

 

Once the sharing session begins, any information that may appear in the master’s Sharing window, such 

as an incoming call popup, will be displayed to other users depending on sharing options, see Section 

오류! 참조 원본을 찾을 수 없습니다..  To participate in a sharing session the user must be online. 

 

Note: The Any windows selection in the Application Sharing Window must be enabled to share a 

browser in the Sharing window, see Section 오류! 참조 원본을 찾을 수 없습니다..  As you move 
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the browser window to the Sharing Master Page, other users in the sharing session see the web page. 

 

12.3.1 Application Sharing Window 

The Sharing Master Page window manages the Application 

Sharing function.  At the top of the window is the sharing 

participant list with the controlling participant indicated by 

the marked radial button.  Icon tools are provided to add 

participants and files as well as to start and stop the sharing 

session.  Also, the master can call and initiate other 

collaborative sessions with a selected participant by 

selecting from the Others tool menu. 

 

To initiate an Application Sharing session: 

1. Open the Sharing Master Page by selecting Application Sharing from any of the main, video or 

other windows or popup menus. 

2. Select participants for the sharing session (refer to Section 12.3.2). 

3. Select files to be shared (refer to Section 12.3.3). 

4. Click on Start to begin the session; this will send an invite message to the selected participants. 

5. If the invitation is accepted, files are shared in the Participant Application Sharing window 

(refer to Section 12.3.4). 

 

The sharing master can pass control to another participant.  The participant becomes the master and 

can then edit documents displayed.  To change control to another participant, click the radial button 

next to the participant name. 

 

Note: Use One-click application sharing in the Tools menu (IM/Video/Call Tab), by clicking on the 

desired Tools menu item; a sharing session will begin with the selected contact and item. 

 

12.3.2 Adding Application Sharing Session Participants 

Selecting the Add member icon from the Application Sharing window, 

opens the the Select Member window.  From this window, you can select 

up to five other participants for the session.  A user must be online to be 

selected as a participant. 

 

To select participants: 

1. Select the Add member icon ( ). 

2. Select participants from the Select Member window. 
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3. Click OK to add the user as a file recipient and return to the Application Sharing window. 

 

12.3.3 Adding Files to Share 

Up to five (5) files from the Open Sharing List can be shared at any one time.  

The master can add and delete files from the list and multiple file types, 

documents, spreadsheets, slide shows, etc., can be selected.  Multiple files 

can be opened in the window simultaneously with the active file displayed on 

the top of the screen. 

 

To select files at any time during the session: 

1. Click the Open ( ) icon, the Open Sharing List opens 

displaying available opened and minimized files. 

2. Select files to be shared from the list. 

3. Click on OK to accept the change. 

 

Additional files can be added to the list from the Open Sharing List window. 

To select other documents: 

1. Click on the Open New Selection List. 

2. Select the document type, Document or 

Paint Board can be selected.  Selecting 

Paint Board opens a blank paint file.  If 

Document is selected, the Open window 

displays. 

3. From the Open window, browse folders in 

the PC to select files to share. 

4. Select the desired file(s). 

5. Click OK to add the file to the Sharing 

List. 

 

Certain types of files such as Internet browsers may not be recognized by the sharing module as 

applicable to sharing.  In this case, selecting Any Windows in the Shared window allows a window to 

be dragged to the Sharing window for display to participants, see Section 오류! 참조 원본을 찾을 

수 없습니다.. 

 

Note: Modifying the Any Windows in the Shared window setting will not affect an active sharing 

session.  To allow sharing all windows, you must terminate the active session and restart the sharing 

function. 
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12.3.4 Application Sharing Participant Window 

When the initiator (Master) begins a sharing session by 

selecting Start, selected participants receive the Invite 

Message popup.  The invited user may then select Yes 

to join the session or reject the invitation by selecting No. 

 

If the user selects Yes to join the 

session, the Sharing Participant window 

displays.  This page displays the 

Member List at the top of the window.  

The radial buttons in the master’s 

window indicates the controlling party.  

The window displays the active shared 

file shown in the master’s window. 

 

At any time, a participant can leave the sharing session by selecting Stop in the upper right corner of 

the window. 

 

12.3.5 Other Participant Tools 

The window includes icon tools so the participant can call 

and initiate other collaborative sessions with a selected 

participant by selecting the appropriate icon tool. 

 

 

 

 

12.3.6 Drawing in Program Sharing mode 

Drawing tools are included for creating drawings 

such as free-form lines.  During an application 

sharing session, clicking one of the Drawing mode 

icons next to the Others button selects a drawing 

activity. 
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 sets color 

 sets line width 

 selects a picture 

 free-form line 

 straight line 

 ellipse 

 rectangle 

 clear all 

 exit 

 

 

12.4 Web Push 

Web Push service permits you to control Web Page views for other users.  In Web Push, you send or 

push a Web Page address (URI) to the online UCS Client of selected users; up to five (5) users may be 

selected.  After the selected users accept the Web Push, their PC Web browser opens and displays the 

Web page. 

 

To push a Web page to other UCS Client users: 

1. Click Web Push from any of the main, video 

or other windows or popup menus. 

2. Click the Add member icon in the top right 

of the Web Push window. 

3. Select the desired recipients (default 

maximum 5) from the list of users displayed. 

4. Enter the Web page address (URI). 

5. Click Send to send the request to the 

recipients. 

 

Each recipient receives an invitation message and can accept 

or reject the invitation.  If the invitation is accepted, the 

recipient’s web browser opens and displays the pushed Web 

page.  To accept the invitation, select Yes in the Invite 

Message popup. 
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12.5 Video Conferencing and Broadcast 

The UCS Client uses a Web Cam and application to implement real-time video communications over 

an IP-based network.  Two types of video conference are available, the 

normal mode and the presentation mode.  In the normal video conference, 

each member sends and receives video from other members.  Up to six (6) 

UCS Client users, including the initiator may be included in a normal Video 

Conference. 

 

In the presentation mode, the initiator broadcasts video to all members and 

members send video only to the initiaitor.  The initiator can broadcast video to 31 parties and will 

receive video from all 31 members of the conference.  Note that in the presentation mode, the initiator 

will need a more powerful CPU to provide quality video. 

 

To initiate a Video Conference: 

1. Click Video or Video (Presentation Mode) from any of the main, video, or other windows or 

popups. 

2. Click on the Add icon from the Video window to display the 

Select Member window. 

3. Select the desired parties from the Member List. 

4. Click OK; each selected party will receive a video call Invite 

Message popup and the inviting party will receive the 

Invite Status Message.  The status can be Accepted, 

Denied or No response.  

5. If the invitation is accepted, click on Send from the Invite 

Status Message window to transmit video. 

6. To add additional parties, repeat steps 2 through 6. 

 

UCS Client users without a Web Cam may be invited to a Video Conference and will receive video 

from the conference, but will not send video.  When receiving a video call, the invited user receives an 

Invite Message: 

1. Click Yes; the Video preview window will open with 

a preview of the PC Cam output. 

2. Click Send from the preview window to transmit 

video. 
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To turn video transmission On or Off, 

1. Right-click below “My image”. 

2. Click on the Stop button. 

 

The Video window displays all parties, maximum 6, in your 

video conference.  You can display a single party if desired.  

To display video from a single party in the Video 

Conference, double click the video frame of the desired 

party. 

 

Note: Resize the Video window by clicking on the lower-right corner and drag to the desired size. 

 

You also have access to tools to place calls or initiate other collaborative sessions with the video session 

participants.  Icon tools are located at the top of the Video window of the initiator or for other 

participants, right click on your picture. 

 

To rotate a video image: 

1. Right-click on the video image. 

2. Select the desired video frame rotation. 
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12.5.1 Video – Remote Monitoring 

A UCS Client located at a remote site can view the web camera output of another client.  To be able 

to monitor another client remotely, that client must be configured to allow monitoring and the 

monitoring client must be configured in the list of users allowed monitoring of the client.  If the client 

is set for you to be monitored, the remote monitoring presence icon will be display on the right side of 

the contact record in the Presence window. 

 

To allow remote monitoring: 

1. Click on the Remote Monitoring Manager from the Video 

menu under the Tools main menu. 

2. Check Use Webcam Presence, and Show notification of 

monitoring to notify the client of the monitoring status. 

3. Click on the Add button to add a user in the Allowed list. 

4. To password protect monitoring of the client, click the 

Password checkbox and enter a password. 

5. Click the Save button. 

 

 

 

 

To start remote monitoring: 

1. Click Start a Remote Monitoring from the Video selection in various menus and popups, the 

Remote Monitoring window will display. 

 

To start recording: 

1. Click the Recording button at the bottom of the Remote 

monitoring screen. 

2. To end recording, click on the Close button in the bottom of 

the screen. 

Note: The recording capacity of your PC is limited only by the 

amount of free space on your hard disk, if your PC has sufficient 

free hard disk capacity, the recording will be saved. 

 

To start monitoring capture: 

1. Click on the Capture button at the bottom of the Remote monitor screen. 

 

Using Remote Monitoring to manage Recorded files: 
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1. Select the Remote Monitoring File Manager from the Video selection of the Tools and other 

menus, the Remote Monitoring File Manager window will display. 

 

 Refresh – update the file list. 

 Delete – to delete the selected file. 

 All Delete – to delete all the files. 

 File Send – selected using a file transfer can be sent to other users. 

 Email – send an email to the selected file attached. 

 Call – make a call (remote monitoring of the target). 

 

12.6 Short Message Service (SMS) 

Short Message Service (SMS) allows you to send and receive text messages with other internal iPECS 

system users or external SMS users.  The UCS Client stores up to ten received messages; additional 

new messages are ignored.  Received messages are stored in the Log window after selecting the SMS 

icon in the main window.  There are two types of SMS, one internal SMS and the other Fixed Line 

(external) SMS. 

 

The iPECS system must be equipped and enabled to 

send and receive external SMS (Fixed Line SMS).  

Internal SMS is for internal users only.  All terminals 

including UCS Clients, Phontage softphones and 

Ericsson-LG IP phones can send and receive text 

messages with other iPECS system users. 

 

To send a text message: 

1. Select SMS from the main, video or other 

windows or popup menus, the SMS window 

displays  

2. Select the Internal radial button to send to other iPECS users. 
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OR 

3. Select the Fixed Line radial button to send an external SMS. 

4. Click the Add icon.  

5. From the Select Member window, select desired members and click OK. 

6. Enter the message in the Message to Send area. 

7. Press the Send button, the Result popup confirms transmission.  

 

To receive a text message: 

1. Click the SMS icon located in the Message and Status bar (refer to Section 5). 

 

12.7 Administrative Messages 

The UCS Administrator can send administrative 

messages to all iPECS UCS Clients.  While online 

or at login, the UCS Client displays the 

administrative message. 

 

 

 

 

 

12.8 Whiteboard 

UCS Clients can efficiently collaborate with 

other clients participating in a meeting using 

Whiteboard to share drawings and free-form 

text.  The drawing function of the Whiteboard 

uses lines, ellipses and rectangles to create 

pictures on the Whiteboard window; pictures can 

be deleted and moved. 

 

At the top left of the Whiteboard are the tools 

icons to add members and manage the file.  To 

the right are the drawing tools discussed below. 

 

To initiate a Whiteboard collaboration session: 

1. Select Whiteboard from the main, video or other windows or popup menus, the Whiteboard 

window will display. 

2. Click the Member icon 
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3. .From the Select Member window, select desired members and click OK.  Each selected party 

will receive a Whiteboard invite message popup, which they can accept, deny or ignore.  The 

inviting party will receive an invite status message. 

4. If the invitation is accepted, click on Send in the invite status message to transmit the 

Whiteboard. 

5. To add additional parties, repeat steps 2through 6. 

 

 sets the color 

 sets line width 

 select the picture drawn 

 drawing free-form line 

 drawing straight line 

 drawing ellipse 

 drawing rectangle 

 clear all 

 fits the Whiteboard size to the drawing area, or zoom (hold the button down). 

zoom setting 

 

12.9 Desktop Sharing 

The UCS Client users can share their desktop screen with another user.  When on a call, the user can 

give control of their desktop to another party on the call for drawing pictures, etc. using the 

Whiteboard.  

 

Note: Screen capture resolution can be 

adjusted to improve transmission 

speed during Desktop Sharing.  The 

lower the screen resolution selected 

the higher operating speed. 

 

To adjust the Screen Resolution: 

1. From the main menu, select File>Setting>Functions>Sharing>Desktop Sharing>Capture 

Resolution (10-100%) 

 

To initiate Desktop Sharing: 

1. From the main screen, click Desktop Sharing, and the Select Member window will appear. 

OR 
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2. Click Desktop Sharing from the presence popup menu; the Desktop Sharing window will 

display. 

3. From the Select Member window, select the desired member and click on OK. 

4. Each selected party will receive a desktop sharing invite message popup, while the inviting 

party will receive an invite status message.  The invitation can be accepted, denied or 

ignored. 

5. Click on the Send button from in the invite status message to transmit desktop sharing. 

 

To initiate the drawing mode: 

1. Click on Drawing Mode from the desktop 

sharing popup menu; the drawing tools 

window will display. 

 sets color 

 sets line width 

 selects a picture 

 free-form line 

 straight line 

 ellipse 

 rectangle 

 clear all 

 exit 

 

To change the controlling user from the session initiator: 

1. Select Handover Control/Takeover Control from the desktop sharing popup menu. 
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13. Supplementary Features 

The UCS Client supports other supplementary features for the user’s convenience 

 

13.1 Call from Outlook Contacts 

UCS Client users can dial the phone numbers from Microsoft Outlook contact databases easily through 

UCS Client.  UCS incorporates a TSP (Telephony Service Provider) for Microsoft Outlook to dial 

phone numbers from the Contacts through telephone systems.  Users download the TSP for UCS 

Client from UCS Server and install it. 

 

Note: This feature is not available for 64-bit versions of the MS operation system. 

 

To install the TSP for UCS Client: 

1. After login, from the main menu, select 

File>Setting>General>Outlook Integration. 

2. Click the link at the left bottom of the window, 

which will download the TSP installation file from 

the UCS Server. 

3. Download and run the TSP installation file. 

 

Note: The link does not display if you already have the TSP 

installed. 

 

To show Microsoft Outlook dialer: 

1. Run Microsoft Outlook and go to 

Contacts. 

2. Right-click on a contact and select 

Call Contact, which displays 

Microsoft Outlook dialer. 

 

Note: If you cannot find the Call Contact item 

in the popup menu, follow the link below to 

correct the popup. 

http://support.microsoft.com/kb/959625/ 
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To configure and dial the Outlook Contact numbers: 

1. Click the Dialing Options button to show the 

Dialing Options window. 

2. Choose UCS Line from the Connect using line 

box. 

 

 

 

 

 

 

 

3. Click OK, and in the New Call window, 

click Start Call from the dialer.  The 

UCS Client will place a call to the 

Contact number through the iPECS 

system. 

 

Note: You can check the dialed digits from LCD 

at UCS Client’s Phone tab.  You may need to configure Dialing Rules for proper operation, refer to 

Section 4.1.3.3. 
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